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C-SMART (Candidate Software for Managing and Reporting Transactions) is a database 
application that stores information about your campaign’s financial activity and creates the
disclosure statements which you will submit to the Campaign Finance Board (“CFB”) and the
Board of Elections (“BOE”).

While this User Guide provides your campaign with all the information necessary to familiarize
yourself with C-SMART, the User Guide should not be viewed as your only resource to navigate the
software. In addition to familiarizing yourself with the User Guide, you are strongly encouraged to
send your staff to the CFB’s training seminars conducted by the Candidate Services Unit. If you
would like to attend a training seminar, please call the Candidate Services Unit at (212) 306-7100.
Sending your staff to training seminars, familiarizing yourself with the User Guide, Handbook, and
the CFB website, as well as keeping in close contact with your Candidate Services Liaison, will all
help to ensure successful compliance with the Campaign Finance Program.

You may find it useful to review the User Guide while actually in front of your computer. In
addition, many people prefer only to refer to specific sections of the User Guide about which 
they have questions, instead of reading through the entire User Guide at once.

In addition to the User Guide, each screen within C-SMART includes a “Help” function you can
select which provides context specific help with the particular screen you are working on.

New in C-SMART v7.0

• Reminder screen to inform you when your next statement is due.

• Internet delivery of disclosure statements.

• A new Cash Flow Report, allowing the user to keep track of money received and disbursed.

• The option of inputting additional bank accounts and information pertaining to those accounts.

• A new Select function on the main screen, for quick access to any transaction.

• An enhanced Advance function requiring the user to input further information and
generating the new Advance schedule.

• New Name Status field.

• New Contributions Prior field to enter amounts received from contributors and not
reported as detailed transactions in C-SMART.
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This chapter will walk you through the process of installing C-SMART onto your computer.

Minimum System Requirements

In order for C-SMART to install successfully, your computer must have an IBM Compatible
90MHz Pentium processor running with the following requirements:

• Windows: 98 Second Edition (SE), ME, NT 4.0 Service Pack 6, 2000, or XP;

• Internet Explorer (IE) 6 or higher or Netscape 6 or higher;

• 64 MB of RAM (128 MB recommended for optimum performance),

• 100 MB of free hard drive space. (Please note that large, citywide campaigns should have up
to 200 MB of free hard drive space to run C-SMART efficiently.),

• CD-Rom Drive and Floppy Disk Drive.

First Steps

This section provides detailed instructions on installing your C-SMART v7.0 CD-ROM. If at any
time you have trouble with the installation process, please contact the Candidate Services Unit at
(212) 306-7100.

1. You must make sure that your computer’s clock and calendar are correct whenever you
use C-SMART. If they are not, C-SMART will be unable to produce accurate disclosure
statements.

2. Exit all other software and place the installation CD in the CD-ROM drive.
The Installation should start automatically. If it does, skip to Step 3. If it does not,
perform the following steps:

a. Click on the [Start] button.

b. Select Run.

c. Click on the [Browse] button.

d. Click in the box labeled “Look in:”.
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e. Click on the yellow dollar sign or the word “C-SMART”.

f. Double-click on the folder labeled “Disk1”.

g. Click on “Setup” or “Setup.exe”.a

h. Click the [Open] button.

i. Click the [OK] button.

3. Follow the prompts that appear on your screen for a “typical” installation. A 
program called “SOAP toolkit 3.0” will also need to be installed. You may be 
prompted to restart/reboot your computer multiple times during the installation 
process, follow the instructions accordingly.

• Click Next

• Click Modify

• Click Install

• Click Finish

• Click Yes, if prompted to restart computer

4. C-SMART is now installed. Double-click on the C-SMART shortcut located on your
desktop. You can log into C-SMART using the default User ID and password, which are
both “ADMIN”.

how to install C-SMART2
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The purpose of this chapter is to summarize the basic menus within C-SMART, and to discuss the
various functions you will be using as you work with C-SMART.

You will maneuver within C-SMART by using both a mouse and the keyboard. In some instances,
certain tasks can be completed by using a combination of keystrokes, or by clicking on a specific 
C-SMART button.

You may move around a screen in C-SMART by clicking on desired items with your mouse. Or you
may press the [Tab] key to move the cursor forward to the next data entry field. Pressing [Shift] +
[Tab] will move the cursor back to the previous field.

At all times, pressing the [Esc] key will close the current screen.

Overview of C-SMART Menu Screens
Every task you perform within C-SMART will be accomplished through selecting one of a variety 
of different menu options. You can access a menu item by clicking on it with your mouse. You may
also access the menus by pressing the [Alt] key. Once you have done this, you may select a particular
menu item by pressing the key for the underlined letter on that particular menu or you may press
the arrow keys on your keyboard to move to a particular menu item that you then select by pressing
the [Enter] key.

For example, you can exit C-SMART from the Main menu by pressing the [Alt] key to activate the
menus, the [F] key to access the File menu, and the [X] key to select Exit.

File Menu

This menu allows you to add, modify, delete, save, and cancel any information you entered into a
particular screen.

C-SMART v7.0 User Guide | chapter 3 5
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Candidate Information

The Candidate Info menu contains information about the candidate, the committee that raises and
spends money on behalf of the candidate, and the committee’s associated bank accounts.

Prior to being able to enter transactions into C-SMART, you must modify the Candidate screen to
select the office that the candidate is seeking and add committee and bank account information.
You must then go to the Defaults screen in the Admin menu to select a default committee and bank
account. For more information on entering your committee information, please refer to Chapter 4:
Entering Your Candidate Information.

Names

C-SMART contains a database of names. This menu allows your campaign to create name records
which contain basic information about individuals and organizations that are involved with your
campaign. A name record provides demographic information for someone who has a specific
relationship to your campaign, such as a contributor, a vendor, a lender, or someone who performs
several of those roles.

C-SMART does not contain separate lists of contributors or vendors; it contains one list of names.
Thus, if one person makes multiple contributions, or a vendor, such as the phone company or a
landlord, charges the campaign on a frequent basis, you only need to enter the name information
for the first transaction. You may then access that name record for all subsequent transactions.

Transactions

The Transactions menu is where you will be entering all of your financial activity (contributions,
bills, loans, etc.). Each transaction includes the name of the individual or entity that performed the
transaction.

For example, when you add or select a monetary contribution, you must first add or select the
name of the contributor. Once you select a name from the name list, you may enter the information
specific to that particular transaction.

When entering data into C-SMART, campaigns do not need to specify which disclosure statement 
a particular transaction will appear on. C-SMART will automatically assign each transaction to the
appropriate disclosure schedule when you run final submission of your disclosure statements,
before you submit them to the CFB and the BOE.

Select

The Select menu is where you can go to any transactions by entering the Transaction ID.

Admin

The Admin menu provides all the utility functions in C-SMART. This menu allows you to import
names from a prior election cycle, backup and restore your current data, set security access, set
defaults, and perform other maintenance.

navigating C-SMART3
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Reports

The Reports menu allows you to view different aspects of your data from different perspectives.

For example, you may use specific reports to examine individual or total contributions and
expenditures or use specific reports to identify potential compliance problems in your data.

Most reports contain selection criteria and different sort orders and many reports can be exported
to database or Excel format for use in your own mailings or database applications.

Submission

This menu allows you to generate disclosure statements for the CFB and the BOE.

Help

The Help menu provides you with additional information about how to use C-SMART.

It includes the following options:

• Help Contents: This shows a table of contents that organizes the various help topics that
are available within C-SMART. From Help Contents, you have access to the following
options:

• Contents: This shows a table of contents that organizes the various help topics that are
available within C-SMART.

• Index: This shows an alphabetical list of all topics that are available within C-SMART.

navigating C-SMART 3
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• Find: This enables you to search for topics that include specific words. The first time that
you access this option, it will walk you through organizing a database of Help topics. After
it is complete, you may type part or all of a word to bring up all help screens that contain
those letters.

• Help on Current Window: This shows the help topic relating to the
current screen. It may also be accessed by pressing the [Shift] + [F1]
keys together or by clicking on the button on the toolbar.

• Campaign Finance Handbook on the Web: This enables you to access the electronic
version of the Campaign Finance Handbook.

• Reminders: This will open up a screen to remind you of disclosure due dates, the CFB
Certification Deadline date, the Primary date, and the Election date.

• About C-SMART: This provides additional information about the current version of C-
SMART and contact information if you need additional assistance.

Additional C-SMART Menus

The following menus are found when you are adding or modifying information within C-SMART.

Add/Select

The Add/Select menu is available within the Name Maintenance and Transaction screens.

navigating C-SMART3
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• From the Name screen, this menu enables you to search for a different name record by
selecting Transaction Name Search.

• From most Transaction screens, this menu enables you to do one of the following:

• Add or select transactions for a different name by selecting Transaction Name Search.

• Add or select transactions for the current name by selecting Transaction Search.

• View a list of all transactions for the selected individual by selecting Transaction List GoTo.

• View a particular transaction by entering the Transaction ID number by selecting
Transaction GoTo.

Window

The Window menu allows you to change the way your screen is organized. It includes the following options:

• Show Toolbar: This toggles between showing and hiding the toolbar.

• Tile Horizontally: This tiles the open screens so that a portion of each is visible and can be selected.

• Cascade: This displays a portion of all open screens so that the name of each screen is
visible and can be selected.

• Layer: This stacks the open screens so that only one can be seen at a time.

• Each open screen is assigned a number which can be selected from the Window menu.
Selecting that number selects that screen and brings it to the front or top of the stack.

navigating C-SMART 3

C-SMART v7.0 User Guide | chapter 3 9



For additional information about the CFB and the Campaign Finance Program, please visit the CFB
web site, www.nyccfb.info, or call the Candidate Services Unit at (212) 306-7100.

Overview of C-SMART Tools

There are several different tools that can be used to select or enter types of information or perform
particular functions. The purpose of each and how they are used are described below:

Buttons

A button can be used to perform a particular function on a screen. There are
two types of buttons: command buttons, which are found at the bottom of a
screen containing text; and toolbar buttons, which are found directly under
the menus and contain a graphic. Both types of buttons can be accessed by
clicking on them with your mouse.

Command buttons that contain text can also be accessed by pressing the [Alt]
key and the key for the underlined letter on that button at the same time. For example, pressing
[Alt] + [C] is the same as clicking on the [Close] button. The [Close] toolbar button can only be
used by clicking it with your mouse.

Edit Fields

An edit field is used to enter or modify text and numbers as appropriate. You may access a text box
by clicking on it with your mouse or tabbing to it. In many instances, you will need to click the
[Modify] button on the toolbar before you may enter or modify information in an edit field.
Once the cursor is blinking, you may type information directly into the box. If part or all of the 
text currently in the box is highlighted, typing will overwrite the highlighted text.

List Boxes

A list box is used to select a specific item from a list of available options. A list box has a downward
pointing arrow on its right. You may access a list box by clicking on it with your mouse or tabbing
to it. Once a list box is highlighted, you may select a particular item from the list by using the up
and down arrows on your keyboard or by pressing the first letter of the desired option.

If the list box has been opened so that you can see the available options, you may select a particular
option with your mouse. For example, you could select “Borough Pres” from either of the two list
boxes shown below by pressing the [B] key.

navigating C-SMART3
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Check Boxes

Check boxes are used to indicate whether something is true or false. A check
box is filled in with an “X” if it has been selected and left blank if it is not
selected. A check box can be accessed and selected by clicking on it with your
mouse or tabbing to it and pressing the [Space Bar].

Radio Buttons

Radio buttons, which are found when reporting transfers or running
submission, are used to select one option from a very small number of
choices. A radio button can be accessed and selected by clicking on it with
your mouse or tabbing to it and pressing the [Space Bar]. Selecting a radio
button will deselect all other radio buttons in the same list.

Selecting a Directory

The Browse button is used when you are either backing up or restoring your
database. It opens a screen and allows you to choose the directory from 
which C-SMART will retrieve information or to which C-SMART will save
information. This button, to the right of the “source” or “destination” field,
can be accessed by clicking on it with your mouse.

Overview of C-SMART Functions

Modify

The Modify function makes it possible to edit the screen that is currently visible. There are two ways
to modify the current screen:

• Go to the File menu and select Modify.

• Click on the [Modify] button on the toolbar.

Once all modifications have been completed, one of the following options must be selected:

• Save

• Cancel

• Delete

• Close

• Main Menu

navigating C-SMART 3
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Save

The Save function checks and permanently records any changes that have been entered into a
particular screen. Changes can only be made to a screen that is being added or modified. If no
changes are being made to a screen, the Save function will have no effect.

The Save function can be accessed by doing one of the following:

• Clicking the [Save] button at the bottom of the screen.

• Going to the File menu and selecting Save.

• Clicking the [Save] button on the toolbar.

Cancel

The Cancel function eliminates any changes that have been entered into a particular screen.
If no changes are being made to a screen, the Cancel function will have no effect.

The Cancel function can be accessed by doing one of the following:

• Going to the File menu and selecting Cancel.

• Clicking the [Cancel] button on the toolbar.

Delete

The Delete function eliminates the record that is currently visible. The contents of a screen cannot
be deleted if they are used on another screen or in another transaction.

For example, a committee cannot be deleted if it contains bank accounts or transactions; a name
cannot be deleted if that name is used in any transactions; a transaction cannot be deleted if it has
been paid, repaid, refunded, or forgiven.

If you want to delete a transaction, you must first delete any associated transactions. If you want to
delete a name, you must first delete all transactions associated with that name.

The Delete function can be accessed in one of the following ways:

• Go to the File menu and select Delete.

• Click on the [Delete] button on the toolbar.

Once Delete is selected, you are prompted to confirm the deletion before you proceed.

navigating C-SMART3
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Close

The Close function exits the specific C-SMART screen that is currently visible. If the screen has just
been added or modified, the Close function will bring up a box which asks whether the changes
should be saved.

• Click [Yes] to save the changes you have made.

• Click [No] to cancel the changes you have made and leave the screen.

• Click [Cancel] to make additional changes to the screen.

The Close function can be accessed by doing one of the following:

• Clicking on the [Close] button at the bottom of the screen.

• Going to the File menu and selecting Close.

• Clicking the [Close] button on the toolbar.

Main Menu

The Main Menu function closes every C-SMART screen that has been opened, returning C-SMART
to the blank main screen.

If the screen has just been added or modified, the Main Menu function will bring up a box which
asks whether the changes should be saved.

• Click [Yes] to save the changes you have made.

• Click [No] to cancel the changes you have made and leave the screen.

• Click [Cancel] to make additional changes to the screen.

The Main Menu function can be accessed by going to the File menu and selecting Main Menu.

navigating C-SMART 3
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The Candidate Info menu provides access to the Candidate, Committee, and Bank Account
screens.

• The Candidate screen can be accessed by going to the Candidate Info menu and
selecting Candidate.

• The Committee screen can be accessed from the Candidate screen
by going to the File menu and selecting Add Comm/Bank or
Select Comm/Bank, or by selecting the [Add Comm] or [Select
Comm] buttons on the toolbar.

• The Bank Account screen can be accessed from the Committee Screen by going to the
File menu and selecting Add Bank Account or Select Bank Account or by selecting the
[Add Account] or [Select Account] buttons on the toolbar.
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Candidate Screen

The Candidate screen stores basic information about a candidate and provides a list of all committees
that have been authorized by the candidate. C-SMART is customized for each candidate for a
specific election cycle. Therefore, if a candidate participates in another election covered by the
Program, or if the same compliance person installs C-SMART for more than one candidate, an
additional copy of C-SMART must be requested. The existing candidate in C-SMART may not be
deleted, and a new candidate may not be added.

The Candidate screen can be accessed from the Main menu, the Committee screen, or the Bank
Account screen by going to the Candidate Info menu and selecting Candidate.

You may perform the following functions from the Candidate screen:

• Modify the Candidate screen.

• Add a Committee by going to the File menu and selecting Add
Comm/Bank, or by selecting the [Add Comm] button on the toolbar.

• Select a Committee by double-clicking on the desired committee or clicking
on the desired committee once, so that it is referenced by the pointer, going
to the File menu, and selecting Select Comm/Bank. You can also select the
[Select Comm] button on the toolbar or double-click on the desired
committee. If there are no committees in the committee list, selecting a
committee will bring up a blank Committee screen.
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• Close the Candidate screen.

• Go to the Main menu.

The following fields appear on the Candidate screen:

• Candidate ID: The Candidate ID is assigned by the CFB. It will remain the same for
every election in which the candidate participates in the Program, and it may not be
changed in C-SMART.

• Election Cycle: This is the year of the election in which the candidate is seeking office.
If the election is a Special Election, the year will be followed by a letter. This may not be
changed in C-SMART.

• Candidate Name: This is the candidate’s name.

• Office Sought: This is the office sought by the candidate.

• Borough: This is the borough that a borough president candidate seeks to represent.
It will be invisible if any other office is selected.

• Committee List: This provides a list of all committees that have been entered.

Committee Screen

The Committee screen stores basic information about a committee and provides a list of all bank
accounts that are associated with the committee.

The Committee screen can be accessed from the Candidate screen by going to
the File menu and selecting Add Comm/Bank or Select Comm/Bank, or by
selecting the [Add Comm] or [Select Comm] button on the toolbar.

entering your candidate information 4
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The following functions may be performed from the Committee screen:

• Modify the committee information.

• Add a bank account for the committee on screen by going to the File
menu and selecting Add Bank Account.

• Select a bank account by double-clicking on the desired bank account 
or clicking on the desired bank account once, so that it is referenced by
the pointer, going to the File menu, and selecting Select Bank Account.
If there are no bank accounts in the bank account list, selecting a bank
account will bring up a blank bank account screen.

• Delete the committee.

• Close the Committee screen.

• Go to the Main menu.

The following fields are available on the Committee screen:

• Committee Name: This is the name of the committee as it is listed with the CFB and
BOE.

• Committee ID: This is the letter assigned to the committee by the CFB when the
campaign files a Filer Registration or Certification. If the campaign has 
not yet filed either form, the Committee ID must be obtained by calling the Candidate
Services Unit. The Committee ID is not based upon the Candidate ID or the Candidate
Name.

• BOE ID: This is the identifier assigned to the committee by the BOE when the campaign
authorizes a committee. This ID may be obtained by calling the BOE.

• Principal Committee: This box should be selected for the campaign’s principal
committee. If the campaign has only one committee, that committee is the principal
committee.

• Committee Address: This contains the committee address. The first line includes fields
for the street number, street name, and apartment number. If the address is a post office
box, the street number should be left blank. Otherwise, the street number and street
name must be separated between the two fields. The second line contains the city, state,
and zip code. The city may be further adjusted if the city name does not match the
borough name, as with Queens addresses.

• Treasurer Name: This contains the first name, middle initial, and last name of the
treasurer.
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• Bank Account List: This provides a list of all bank accounts that are associated with the
committee. If no bank accounts have been entered, it will be blank.

Bank Account Screen

The Bank Account screen stores information about the committee’s bank account(s).

The Bank Account screen can be accessed from the Committee screen by
going to the File menu and selecting Add Bank Account or Select Bank
Account, or by double-clicking on the bank account. You can also select the
[Add Account] or [Select Account] buttons on the toolbar.

The following functions may be performed from the Bank Account screen:

• Add a new bank account by going to the File menu and selecting Add or selecting the
[Add] button on the toolbar.

• Modify the bank account information.

• Delete the bank account.

• Close the Bank Account screen.

• Go to the Main menu.
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The following fields are available on the Bank Account screen:

• Bank Name: This is the full or abbreviated name of the bank at which the account is
maintained.

• Account Number: This is the account number. It must not contain any punctuation,
hyphens, or spaces, and it must not begin with a zero.

• Nick Name: This is a short version of the bank account name, Ex. Vercetti 05 checking
account.

• Purpose: This is a way to designate what the account will be used for.

Entering Candidate Information

The following tutorial provides step-by-step instructions on entering the required candidate,
committee, and bank account information. This information must be saved before you can enter
transactions in C-SMART.

1. Go to the Candidate Info menu, and select Candidate. Go to the File
menu and select Modify, or click the [Modify] button, and select the
office sought by the candidate and, if the candidate is seeking the office
of Borough President, the borough in which the candidate is seeking
office. Save the Candidate screen.
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2. Modify the Committee by going to the File menu and selecting Select
Comm/Bank, or click the [Select Comm] button.

3. Fill in all required committee information, and Save the Committee
screen.

4. Add a Bank Account by going to the File menu and selecting Add Bank
Account, or click the [Add Accnt] button.

5. Fill in all required bank account information, and Save the Bank Account screen.

6. If this committee has additional bank accounts, repeat steps 4 and 5 for each 
bank account.

7. Return to the Committee screen by clicking on the [Close] button.

8. Return to the Main menu by going to the File menu and selecting Main Menu.

9. Go to the Admin menu and select Defaults. Go to the File menu and select Modify or
click the [Modify] button. Select the committee and bank account that are used for most
of the campaign’s financial activity. Save the Defaults screen.

10. If you have filed disclosure statements without using C-SMART, you must enter all
previously disclosed transactions into C-SMART and run submissions, in sequential
order, for each disclosure statement that was previously filed with the CFB before any
subsequent filings are made. This will enable C-SMART to more accurately and
completely reflect the current status of the campaign.

Defaults

The Defaults screen lists a committee, bank account, and monetary contribution date that will be
automatically applied to any transaction that is entered in C-SMART. When entering a transaction
you may change the information from the default when it does not apply.

The Defaults screen can be accessed by going to the Admin menu and selecting Defaults.

entering your candidate information 4

C-SMART v7.0 User Guide | chapter 4 21



The following functions may be performed from the Defaults screen:

• Modify the defaults.

• Cancel any changes.

• Save changes to the defaults.

• Close the Defaults screen.

• Go to the Main menu.

The following fields are available to edit on the Defaults screen:

• Committee: This is the campaign’s default committee. Any transaction that is added will
initially be attributed to this committee.

• Bank Account: This is the campaign’s default bank account. Any transaction that is
added will initially be attributed to this bank account.

• Date (Monetary Contributions only): This is the default date for monetary
contributions. Any monetary contribution that is added will be assigned this date.

C-SMART is now ready for names and transactions to be entered.
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The Name Maintenance screen stores basic information about a particular individual or entity who
is involved with your campaign. C-SMART keeps one list of names for each campaign. Thus, even 
if a name serves in multiple capacities, such as a contributor and a vendor, or serves in one capacity
on multiple occasions, such as sending several different bills to the campaign, only one name record
is required. C-SMART does not keep separate contributor and vendor lists. The same list may be
accessed for any transaction.

Name Search

The Name Search provides a list of all names, with Name Codes (N-Code) and addresses that have
been entered into C-SMART.

The Name Search can be accessed in any of the following ways:

• From the Main menu by clicking on the Name menu.
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• From the Name Maintenance screen by going to the Add/Select menu and selecting 
Name Search.

• From the Name Maintenance screen by clicking on the [Name Search] button on 
the toolbar.

The following functions may be performed from the Name Search screen:

• Click once on a specific name record to highlight it.

• Click the [Add Name] button to create a new name record.

• Click the [Select] button to bring up the highlighted name record.

• Click the [Close] button to close the screen.

Search Box

The Search box makes it possible to limit the name list so that you can find a particular name more
easily. The Search box appears on all Name Search screens.

If a search is accessed from a Name or Transaction screen rather than from the Main menu, the Last
Name and First Name fields in the Search box will automatically contain the name from that screen.
The contents of these fields may be edited or deleted by clicking in them and typing updated search
information.

The following buttons are available in the Search box:

• The [Search] button allows you to type in the letters of the last name and first name. C-
SMART then conducts an incremental name search, locating the name or the closest
match to that name.

• The [Clear] button empties the contents of the First Name and Last Name fields.
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Name Maintenance

The Name Maintenance screen can be accessed by going to the Names menu. This will then bring
up a Name Search screen that will allow you to add a new name or select an existing name record.

The following name editing functions may be performed from the Name Maintenance screen:

• Add a new name by going to the File menu and selecting Add or selecting the [Add]
button on the toolbar.

• Modify the name appearing on the screen.

• Select another name through the Name Search by going to the Add/Select menu and
selecting Name Search.

• Delete the name on screen if it is not associated with any transactions.

• Cancel any changes made to the name.

• List all transactions that have been entered for that name by going to the File menu and
selecting Transaction List.

• Save any changes made to the name.

• Close the Name screen.
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• Go to the Main menu.

The Name screen is broken down into the four sections described below.

General Information

• Name Code: The Name Code (N Code), identifies the individual or entity that a name
record represents.

• Individuals:

— CAN: The candidate

— SPO: The candidate’s spouse

— FAM: The candidate’s parents, siblings, and children

— IND: Any individual not described above.

• Political Committees:

— PCOMC: Candidate committee

— PCOMP: Political Action Committee

— PCOMZ: Political party committee

• Organizations (except political committees):

— CORP: Corporation

— EMPO: Employee organization, including a union or guild

— LLC: Limited Liability Company

— PART: Partnership

— OTHR: Any entity not described above

• If the Name is for a Person:

• Last Name: This contains the person’s last name.

• First Name: This contains the person’s first name.

• Middle Initial: This contains the person’s middle initial.

• If the Name is an Organization:

• Name: This contains the organization’s name.

• Street: These two fields contain the first line of the address.

• Street Number: This should only contain the street number. If the name is for an
organization and the address is a P.O. Box, this field should be left blank.
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• Street Name: This should only contain the street name. It may also contain geographic
identifiers, such as “East.” It must never contain the street or apartment number.

• Apartment Number: This should only contain the apartment number.

• City: This should contain the city. If you enter a New York City zip code, this will
automatically include the borough in which that zip code is located.

• State: This should contain the state. If you enter a New York City zip code, this will
automatically include “NY.”

• Zip: These two fields hold the five-digit zip code and the +4 zip code, respectively.

• Borough: This should indicate the borough in which the person or organization is
located or indicate that the person or organization is outside of New York City.
This will be automatically filled in once you enter a zip code.

• District Resident: This checkbox should be filled by campaigns for City Council if the
name belongs to an individual who lives in the Council District that the candidate is
running to represent. It is the responsibility of each campaign to identify and indicate
district residents in order to fulfill part of the threshold for receiving public matching
funds. This field is not used for any other office. If you are running for an office other
than City Council, you may leave this checkbox blank.

• Intermediary Number: If the name is for an intermediary — someone who solicits,
collects, and delivers contributions to the campaign — this field should hold a unique
number beginning with 1 and continuing in numerical order as each new intermediary
is added. The candidate, his or her immediate family, consultants, full-time campaign
staff and volunteers, and professional postal and delivery workers are not considered 
to be intermediaries.

• Contributions-Prior: This optional field is used to indicate the amount of a
contribution transferred into your campaign account from an individual or organization
that contributed in a previous election cycle.

• Totals: This field shows the total amount that this individual has contributed towards
your campaign, including transfers.

• Status: This field is used to categorize name records into Active, Inactive, and On-Hold
categories.

Employment Information

This should only be filled out if the name is for a person, rather than an organization.
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• Company Name: This should contain the name of the company that employs the
individual. If the individual is self-employed, enter “Self-Employed.” All other
employment information must be filled in for self-employed individuals.

• Occupation: This should contain the individual’s job title. Listing the industry in which
the individual works is not sufficient. For example, “Real Estate Developer” may be an
occupation, but “Real Estate” is not. If the individual is unemployed, retired, a homemaker,
or a student, that word should be placed in this field and all other employment information
should be left blank.

• Street: These two fields contain the first line of the employer’s address.

• Street Number: This should only contain the street number. If the employer’s address is 
a P.O. Box, this field should be left blank.

• Street Name: This should only contain the street name. It may also contain geographic
identifiers, such as “East.” It must never contain the street number or room or floor.

• Room/Floor: This should only contain the room or floor information.

• City: This should contain the city. If you enter a New York City zip code, this will
automatically include the borough in which that zip code is located.

• State: This should contain the state. If you enter a New York City zip code, this will
automatically include “NY.”

• Zip: These two fields hold the five-digit zip code and the +4 zip code, respectively.

Affiliations

This should only be filled out if the name is for a contributor who is affiliated with another
contributor. Examples of affiliated contributors include a person and the store that he or she 
owns, or a union and its political action committee.

• Affiliated Group: This should indicate the group of which the contributor is a member.
If the desired group is not in the list that can be found in this box, you need to go to the
Affiliated Group screen and create it.

• How Affiliated: This should indicate how this name is affiliated with the group.

For more information on disclosing affiliations, see the Campaign Finance Handbook.

Contact Information

This information is not required and nothing that is entered in these fields will be disclosed to the
CFB or the BOE during the submission process. Using these fields to store other information about
a contributor can be helpful if you choose to run reports for mail merges. For more information on
Reports, see Chapter 8.
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The purpose of this chapter is to instruct you on how to enter transactions into C-SMART.
All transactions can be found under the Transactions menu.

Transactions Basics

When you enter transaction information, you will notice that each transaction screen stores basic
information about a particular transaction, lists totals that aggregate multiple transactions entered
for the same individual or entity, and provides a list of all other associated transactions that have
been entered for that transaction.

C-SMART allows you to enter information for the following transactions:

• Monetary Contributions

• In-kind Contributions

• Public Funds Payments
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• Transfers In

• Other Receipts

• Bills

• Transfers Out

• Advances

• Petty Cash Fund

• Loans

• Partnership/LLC attributions

• Subcontractors

• Affiliated Groups

Information for a specific transaction is entered into C-SMART by going to the Transactions menu
and selecting the particular transaction type that is desired.

Transaction-Name Search and Transaction Search

Once you select a transaction type from the Transactions menu, the Transaction-Name Search
screen will appear, providing a list of all the names you entered into C-SMART. It also lists the
number of transactions associated with the name for the particular transaction for which you 
are searching.
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The Transaction-Name Search screen can be accessed in one of the following ways:

• Go to the Transactions menu from the Main menu, or from another transaction screen,
and select the desired transaction type.

• Click on the [Name Search] button on the toolbar of any transaction
screen, or choose Transaction-Name Search from the Add/Select menu
in any transaction screen.

The following should be performed in order to select a name from the Transaction-Name 
Search screen:

• Type in the letters of the last name and first name. C-SMART will conduct an
incremental name search, locating the name.

• Click once on a specific name record to highlight it.

• If the name is not found, click the [Add Name] button to create a new name record
which will then be used for a new transaction.

• Click the [Add Transaction] button to create a new transaction for the highlighted name.

• Click the [Show Transaction] button or double-click on a name to bring up the
Transaction List for that name.

• Click the [Close] button to close the screen.

The Transaction Search screen shows a list that contains basic information about every transaction
made by an individual or entity for the transaction type for which you are searching.
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The Transaction Search screen can be accessed in one of the following ways:

• From the Transaction-Name Search screen, double-click on the name for which a list is
desired or click the [Show Transaction] button when the name for which a list is desired
is highlighted.

• By clicking on the [Transaction Search] button from the toolbar, or by
selecting Transaction Search from the Add/Select menu within the
transaction you are working on.

If you wish to select a transaction from the Transaction Search screen, please do the following:

• Click once on a specific transaction to highlight it.

• Click the [Select Transaction] button or double-click on a transaction to bring it on screen.

• Click the [Add Transaction] button to create a new transaction for the listed name.

• Click the [Close] button to return to the prior screen.

Transactions and Associated Transactions

The first time you enter a transaction into C-SMART, it is considered by C-SMART as the “main”
or “initial” transaction. For example, if you enter a bill invoice into C-SMART, that invoice is
considered the initial transaction and is assigned a transaction ID number. Many initial transactions
have “associated transactions”. An associated transaction is a transaction that is connected to or
dependent upon another transaction which has previously been entered into C-SMART.

For example, when you enter a bill payment into C-SMART, you will be adding an associated
transaction. This is because the bill payment is connected to the initial bill transaction (you cannot
pay a bill that you have not received.) An associated transaction can only be accessed from the main
transaction screen with which it is associated.
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Most associated transactions use the same name record that is used by the main transaction.

For example, if you refund a monetary contribution, you are refunding money to the person or
organization who made the original contribution. Thus, the refund uses the same name record as
the original contribution.

The following is a list of associated transactions in C-SMART:

• Advance Purchases and Advance Repayments (with Advancers)

• Bill Payment, Expenditure Refunds, and Forgiven Bills (with Bills)

• Forgiven Loans and Loan Payments (with Loans)

• In-kind Contribution Refunds (with In-kind Contributions)

• Monetary Contribution Refunds (with Monetary Contributions)

• Partnership/LLC Attributions (with Total Contributed)

• Petty Cash Deposits and Petty Cash Disbursements (with Petty Cash Fund)

• Public Funds Repayments (with Public Funds Payments)

• Subcontractor Attributions (with Total Billed)

Accessing Associated Transactions

An associated transaction screen can only be accessed from the main transaction with which it is
associated. All transactions that are associated with a particular transaction are listed at the bottom
of the main transaction screen. If the main or initial transaction has no associated transactions, that
area of the screen will be blank.

An associated transaction can be added from the main transaction several ways.

• By going to the File menu.

• By clicking on the [Add] button within an associated transaction screen.

• By clicking on the appropriate associated transaction button on the toolbar when
working with the initial transaction.

It is not possible to access any menu items from an associated transaction. However, the following
functions may be performed from buttons on an associated transaction screen:

• Add a new associated transaction by clicking the [Add] button.

• Modify the associated transaction on screen by clicking the [Modify] button.
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• Delete the associated transaction by clicking the [Delete] button. Once Delete is selected,
you are prompted to confirm the deletion before it will allow you to proceed.

• Save the associated transaction by clicking on the [Save] button.

• Close the associated transaction, returning to the main transaction, by clicking the
[Close] button.

If the transaction has just been added or modified, the Close function will bring up a box which
asks whether the changes should be saved.

• Click [Yes] to save the changes that have been made.

• Click [No] to cancel the changes have been made.

• Click [Cancel] to make additional changes to the screen.

Entering a Transaction

After you select the type of transaction you would like to enter, you must first add or select the
name of the person or entity that made the transaction. For information on adding or selecting
names, see page 25.

Transactions can be entered in any one of the following three screens:

• Transaction-Name Search screen

• [Add Name] button
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• [Add Transaction] button

• Transaction Search screen

• [Add Transaction] button

• Transaction screen

• File menu, Add

After adding or selecting the name, you are ready to enter the transaction.

Entering a Monetary Contribution

The Monetary Contributions transaction records information about transactions in which 
money is given to a campaign. It can be accessed by going to the Transactions menu and 
selecting Monetary Contributions.

When you choose to enter a monetary contribution, the following data entry fields will be available
for you to enter information about the contribution. After you are done entering information into 
a field, you may move to the next field by pressing the [Tab] key or by clicking on the next field
with your mouse.
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• Date Received: This is where you will enter the date that the campaign receives the
contribution. It may or may not match the date written on the check or the date that a
contribution card was signed. If you have entered a date in the Defaults screen, it will
automatically be listed when you add new transactions.

• Contribution Type: You must select a contribution type for every contribution you receive.

• Select Cash if the contribution was made in cash. Make sure that you have a contribution
card which conforms to the CFB’s contribution card requirements. Remember, state law
prohibits accepting more than $100 in cash from the same contributor for the entire
election cycle.

• Select Check if the contribution was made by check.

• Select Credit Card if the contribution was made by credit card.

• Select Money Order if the contribution was made by money order. Make sure that you
have a contribution card which conforms to the CFB’s contribution card requirements.
Remember, the CFB will only match the first $100 of a money order contribution.

• Select Other if the contribution was made through another financial mechanism.

• Check or M.O. Number: This is the check or money order number if the contribution
was made by check or money order. If the money order number exceeds fifteen digits,
you should enter the last fifteen digits of the number in this field.

• Committee: This is the campaign committee that received the contribution. The
committee you have entered in the Defaults screen will automatically be listed when you
add new transactions.

• Contribution Amount: This is the amount of the contribution.

• Matchable Amount: This is the amount of the contribution that can be matched. It is
not the amount of public funds that would be paid by the CFB, which would be four
times the matchable amount. Only monetary contributions from individual New York
City residents can be matched, and the matchable amount cannot exceed the contribution
amount. C-SMART will not allow you to save an amount that exceeds the maximum
matchable amount per contributor per election.

• For example, should you receive a check contribution from a New York City resident 
for $500 dollars, you would enter $250 into the Matchable Amount field.

• Optional Information About Source of Contribution: This field is solely for the
campaign’s use and will not be made available to the public. You may include any
information about this contribution that may be needed later, including fundraiser
information.
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• Intermediary Information: This box is used to provide intermediary information about
a contribution. For more information on how to enter intermediary information, please
see page 39.

• Runoff/Rerun: If the contribution was given for a runoff or rerun election you should
check the box. For more information on runoff or rerun elections please refer to the
Campaign Finance Handbook.

• Segregated: If the contribution received was for the campaign's segregated bank account
you should check the box. Segregated contributions are not matchable and for more
information please refer to the Campaign Finance Handbook.

Monetary Contribution Refunds

A monetary contribution refund is an associated transaction for monetary contributions. Entering a
monetary contribution refund will record information about transactions in which all or part of a
monetary contribution is returned to a contributor.

A monetary contribution refund can be entered by going to the Transactions
menu, selecting Monetary Contributions, choosing the name and contribution
that the refund is associated with, and then adding or selecting a contribution
refund.

If you receive public funds, you will not be allowed to make most contribution refunds. Refer to 
the Campaign Finance Handbook or call the Candidate Services Unit for details.
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When you choose to enter a monetary contribution refund, the following data entry fields will be
available for you to enter information about the contribution refund. After you are done entering
information into a field, you may move to the next field by pressing the [Tab] key or by clicking on
the next field with your mouse:

• Refund Date: This is the date that the campaign refunds the contribution.

• Amount Refunded: This is the amount of the refund.

• Check Number: This is the number of the check written by the campaign. If the campaign
is returning the contributor’s check, this should be left blank.

• Refund Type:

• Select Returned Check if you are returning the contributor’s check without depositing it
or if the contributor’s check bounced. You should attempt to redeposit a bounced check 
at least once before returning it.

• Select Refund if you are writing a check to refund some or all of the original contribution.

• Select Other under other circumstances. If you select other, you must enter a reason in the
Reason field.

• Matching Amt. Refunded: This is the amount by which the contributor’s matchable
claims should be reduced by the refund. The total matchable amount for a contributor
cannot exceed the total monetary contributions received from that contributor.

• Bank Account: This is the bank account from which the campaign check was written.
If the campaign is returning the contributor’s check, this should be left blank. If the
original contribution was received by the default committee, then the default bank
account will automatically be listed when you add new transactions. You may still 
change this bank account if it does not apply to a specific transaction.

• Reason: This should only be filled in if the Refund Type is Other. This field contains an
explanation of the reason for the refund.

Totals

The Totals box on each transaction screen provides
information about the overall financial activity for the
name listed for the transaction. If someone performs
multiple transactions, the Totals box will reflect the
combined value of all of them, rather than the amount 
of an individual transaction.

The contribution total is the most complicated total in C-SMART. It is calculated by totaling
Monetary Contributions + In-Kind Contributions + Transfers In (Type 1) + Partnership/LLC
Attributions + Advance Purchases + Bills Forgiven + Loans Forgiven + Prior Contribution 
Amount – Contribution Refunds – Advance Repayments.
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The Totals box does not reflect unitemized contributions, contributions made by Affiliated Groups,
contributions that have been attributed from Type 2 transfers (received from a committee
authorized by the same candidate for a different election), or contributions that were disclosed
without using C-SMART. Your campaign is responsible for ensuring that it complies with the
contribution limit and other rules and laws that govern participation in the Program.

If a problem develops with the totals, it may be resolved using Recalculate Totals under the Admin
menu, accessed from the Main screen. For more information on recalculating totals, see page 69.

Intermediary Information

Intermediaries are people who, or organizations that, solicit, collect, and deliver contributions to 
a campaign from other people or organizations. They are sometimes called “bundlers”. Since they 
can deliver contributions that aggregate well over individual contribution limits, the law requires 
that you report intermediaries and the contributions they deliver. A postal, delivery, or messenger
service, or a contributor’s immediate relatives are not considered intermediaries. If someone
intermediates a contribution, it must be disclosed in the Intermediary box on the particular
monetary contribution or in-kind contribution that he or she has intermediated. Do not forget 
to submit an intermediary statement signed by the intermediary along with your backup
documentation.

The following data entry fields are available in the Intermediary box:

• Intermediary Search Box: Click in this box to activate the Intermediary Search. The
following functions may be performed from the Intermediary Search box in order to
select an intermediary:

• Type in the letters of the last name and first name. C-SMART will conduct an
incremental name search, locating the name.
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• Click once on a specific name record to highlight it.

• Click the [Add Name] button to create a new name record if you have not previously
entered the intermediary into C-SMART. You will be required to assign the name a unique
intermediary number prior to saving it. This name will be listed as the intermediary for
this contribution.

• Click the [Modify Name] button to edit a name record. Although you may make any
desired modifications to the name record, this is designed to enable you to add an
intermediary number to an existing name. You will be required to assign the name a
unique intermediary number prior to saving it. This name will be listed as the
intermediary for this contribution.

• Click the [Select] button to use a name as an intermediary. If you have not already
assigned an intermediary number to the desired name, you will need to assign such a
number first. In that case, you will have to click the [Modify Name] button instead.

• Click the [Close] button to close the screen.

• ID: This contains the ID number that has been assigned to this intermediary. If you
have already assigned an ID, and you know the ID, you may type it directly into this box.
If you have not assigned an ID or if you do not know what ID you have assigned, you
should click in the Intermediary Search box. After you add or select an intermediary,
C-SMART will automatically place the appropriate ID in this field.

• Intermediary Name: After you enter an
intermediary number or select an intermediary
using the intermediary search, C-SMART will list
the name of the intermediary in this box.

Entering In-kind Contributions

The In-kind Contributions transaction records information about transactions in which goods or
services are provided to a campaign for free or at a reduced price. The In-kind Contributions screen
can be accessed by going to the Transactions menu and selecting In-Kind Contributions.

When you choose to enter an in-kind
contribution, the following data entry fields
will be available for you to enter information
about the in-kind contribution. After you are
done entering information into a field, you
may move to the next field by pressing the
[Tab] key or by clicking on the next field with
your mouse:
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• Date Received: This is the date that the campaign receives the in-kind contribution. If
the in-kind contribution came in the form of a service which was provided, you would
enter the last date in the disclosure period in which the service was provided.

• Contribution Amount: This is the amount of the contribution. If the good or service is
provided for free, this is the fair market value of the contribution. If the good or service
is provided at a reduced price, this is the difference between the amount charged and the
fair market value of the contribution. Since an in-kind contribution is considered both a
contribution and an expenditure, this amount is counted towards the contributor’s
contribution limit and the campaign’s expenditure limit. There is no need to enter an 
in-kind contribution as an expenditure or “bill” into C-SMART.

• Purpose Code: You must choose the category that most closely represents the purpose
this contribution will serve.

• Exempt Code: If the value of this contribution should not be included in the expenditure
limit, select the appropriate exempt category. You must follow all rules for exempt
expenditures. For information on exempt expenditures see the Campaign Finance
Handbook.

• Contribution Type: You must choose the category that explains the type of contribution
that was made.

• Reason/Explanation: This field contains a description of the contribution or its purpose.

• Committee: This is the campaign committee that received the contribution. The
committee you entered in the Defaults screen will automatically be listed when you add
new transactions.

• Intermediary Information: This box is used to provide intermediary information about
a contribution.

• Runoff/Rerun: If the in-kind contribution was given for a runoff or rerun election you
should check the box. For more information on runoff or rerun elections please refer to
the Campaign Finance Handbook.
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In-kind Contribution Refunds

Entering an In-kind Contribution Refund associated transaction records information about 
in-kind contribution transactions in which all or part of an in-kind contribution is returned 
or all or part of the value of an in-kind contribution is paid to a contributor. A refund can be 
entered by going to the Transactions menu, selecting In-Kind Contributions,
choosing the name and contribution that was refunded, and then adding or
selecting a contribution refund.

If you receive public funds, you will not be allowed to make most in-kind contribution refunds.
Refer to the Campaign Finance Handbook or call the Candidate Services Unit for details.

When you choose to enter an in-kind contribution refund, the following data entry fields will be
available for you to enter information about the in-kind contribution refund. After you are done
entering information into a field, you may move to the next field by pressing the [Tab] key or by
clicking on the next field with your mouse:

• Bank Account: If a contributor is being repaid, this is the bank account from which the
campaign check was written. If the original contribution was received by the default
committee, then the default bank account will automatically be listed when you add new
transactions. You may still change this bank account if it does not apply to a specific
transaction. If you are returning a contributed good, this field should be left blank.

• Refund Date: This is the date that the campaign refunded the contribution.

• Amount: This is the amount of the refund.

• Check Number: If a contributor is being repaid, this is the number of the check written
by the campaign. If you are returning a contributed good, this field should be left blank.
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Entering Public Funds Payments

The Public Funds Payments transaction records information about public funds payments from
the CFB to your campaign. It can be accessed by going to the Transactions menu and selecting
Public Funds Payment. If all or part of a public funds payment has been repaid, the Public Funds
Repayment records can also be accessed from this screen.

When you choose to enter a public funds payment, the following data entry fields will be available
for you to enter information about the payment. After you are done entering information into a
field, you may move to the next field by pressing the [Tab] key or by clicking on the next field with
your mouse:

• Payment Date: This is the date that the CFB makes the payment.

• Payment Amount: This is the amount of the public funds payment.

• Repayment List: This provides a list including every repayment that has been made against
this public funds payment. If no part of this payment has been repaid, it will be blank.
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Public Funds Repayments

The Public Funds Repayments associated transaction records information about
transactions in which all or part of a public funds payment is returned to the CFB. It can
be accessed by going to the Transactions menu, selecting Public Funds Payments,
selecting the payment that was repaid, and then adding or selecting a public funds
repayment.

When you choose to enter a public funds repayment, the following data entry fields will be available
for you to enter information about the repayment. After you are done entering information into a
field, you may move to the next field by pressing the [Tab] key or by clicking on the next field with
your mouse:

• Bank Account: This is the bank account from which the campaign check was written.
The default bank account will automatically be listed when you add new transactions.
You may still change this bank account if it does not apply to a specific transaction.

• Date Repaid: This is the date that the campaign repays the public funds payment.

• Amount: This is the amount of the repayment.

• Check Number: This is the number of the check written by the campaign.
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Entering Transfers In

The Transfers In transaction records information about transactions in which the campaign
receives money from a particular type of political committee. Specifically, a transfer in occurs when
money is received from a party committee, such as a county or state political party, or when the
money is transferred between two committees authorized by the same candidate for another
election. Money received from candidate committees authorized by another candidate, or any other
political committee, including a political action committee (“PAC”), must be disclosed as a
monetary contribution, rather than as a transfer in. Transfers In can be accessed by going to the
Transactions menu and selecting Transfers In, and then selecting the name of the committee
making the transfer.

When you choose to enter a transfer in, the following data entry fields will be available for you to
enter information about the transfer. After you are done entering information into a field, you may
move to the next field by pressing the [Tab] key or by clicking on the next field with your mouse:

• Committee: This is the campaign committee that received the transfer. The committee
you entered in the Defaults screen will automatically be listed when you add new
transactions.

• Transfer Date: This is the date that the committee receives the transfer.

• Transfer Amount: This is the amount of the transfer.

• Check Number: This is the check number if the contribution was made by check. If the
check number exceeds six digits, you should enter the last six digits of the number in 
this field.
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Transfer Type:

• Select Type 1 if the transfer came from a constituted committee, such as a state or county
party committee. Although Type 1 transfers are disclosed differently, they are considered
to be contributions and are subject to the contribution limit and all other rules that
govern contributions.

• Select Type 2 if the transfer came from another committee authorized by the same
candidate but for a different election. These transfers are not subject to the contribution
limit. However, each contribution within this transfer is subject to the contribution limit.
The receiving committee must identify the last contributions received by the committee
performing the transfer, up to the dollar amount of the transfer. Contributions that would
exceed the contribution limit or violate any rules of the Campaign Finance Program may
not be transferred, and the total amount transferred must be lowered by the amount of
such contributions. If that committee is subject to the rules of the Program, you must also
enter a Transfer Out for that committee.

• Runoff/Rerun: If the transfer was received for a runoff or rerun election you should check
the box. For more information on runoff or rerun elections please refer to the Campaign
Finance Handbook.

• Segregated: If money was transferred to the campaign's segregated bank account you
should check the box. For more information about the segregated bank account please
refer to the Campaign Finance Handbook.

Entering Other Receipts

The Other Receipts transaction records information about transactions in which money is received
by a campaign through a mechanism other than a contribution, such as bank interest. Although
public funds payments are disclosed as Other Receipts, they should be entered into C-SMART
separately, using the Public Funds Payments transaction. Other Receipts can be accessed by going to
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the Transactions menu, selecting Other Receipts, and selecting a name record from the
Transaction-Name Search screen.

When you choose to enter an Other Receipt, the following data entry fields will be available for you
to enter information about the transaction. After you are done entering information into a field,
you may move to the next field by pressing the [Tab] key or by clicking on the next field with 
your mouse:

• Date Received: This is the date that the campaign receives the receipt.

• Receipt Amount: This is the amount of the receipt.

• Receipt Type: Select the appropriate type. If no type accurately categorizes the receipt,
select Other.

• Reason: This should only be completed if the Receipt Type is Other. This field contains a
description of the receipt.

• Committee: This is the campaign committee that received the receipt. The committee
you entered in the Defaults screen will automatically be listed when you add new
transactions.

• Runoff/Rerun: If the receipt was received for a runoff or rerun election you should
check the box. For more information on runoff or rerun elections please refer to the
Campaign Finance Handbook.

• Segregated: If the receipt received was for the campaign's segregated bank account you
should check the box. For more information about the segregated bank account please
refer to the Campaign Finance Handbook.

Entering Bills

The Bills transaction records information about invoices you receive and bills you pay. You will
enter the majority of your expenditures under the Bills transaction. It can be accessed by going to
the Transactions menu and selecting Bills, and then selecting the name of the vendor where the
expenditure occurred.

Bills are entered into C-SMART as part of a two-step process. The first step is the entry of the 
bill itself. You will enter into C-SMART all applicable information about the bill. After entering 
and saving the bill information, you must then enter a Bill Payment (the associated transaction).
In order for the CFB to consider an expenditure paid, a Bill Payment must be entered.
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If all or part of a bill has been paid or forgiven, or all or part of a bill payment has been refunded,
the Bill Payment, Forgiven Bill, and Expenditure Refund associated transactions can also be
accessed from the initial Bill transaction screen.

When you choose to enter a bill, the following data entry fields will be available for you to enter
information about the bill. After you are done entering information into a field, you may move 
to the next field by pressing the [Tab] key or by clicking on the next field with your mouse:

• Invoice Date: This is the date that the campaign received the bill.

• Purpose Code: You must choose the category that most closely represents the purpose
this bill serves.

• Exempt Code: If the value of this bill should not be included under the expenditure
limit, select the appropriate exempt category. You must follow all rules for exempt
expenditures. If a bill is only partially exempt, you should enter the exempt and 
non-exempt portions as separate transactions. You may pay them both with one check,
but you must enter two separate bill payments, each of which should report the same
check number used to pay one bill. For more information on exempt expenditures,
see the Campaign Finance Handbook.

• Committee: This is the campaign committee that incurred the bill. The committee you
entered in the Defaults screen will automatically be listed when you add new
transactions.

• Bill Amount: This is the amount of the bill.

• Reason/Explanation: This field contains a description of the purpose this bill serves.

• Runoff/Rerun: If the bill was incurred for an expense relating to a runoff or rerun
election, you should check the box. For more information on runoff or rerun elections
please refer to the Campaign Finance Handbook.
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• Segregated: If the bill was a contribution to another campaign and the money was from
the campaign's segregated bank account, you should check the box. For more
information about this please refer to the Campaign Finance Handbook.

• Associated Transaction List: This provides a list of all bill payments, forgiven bills, and
expenditure refunds that have been made against this bill. If no part of this bill has been
paid or forgiven, it will be blank.

Bill Payments

The Bill Payment associated transaction records information about bill payments. It can be
accessed by going to the Transactions menu, selecting Bills, choosing the name and bill that was
paid, and then adding or selecting a bill payment.

When you choose to enter a bill payment, the following data entry fields will be
available for you to enter information about the payment. After you are done
entering information into a field, you may move to the next field by pressing the
[Tab] key or by clicking on the next field with your mouse:

• Paid Date: This is the date that the campaign paid the bill.

• Check Number: This is the number of the check written by the campaign.

• Paid Amount: This is the amount of the payment.

• Bank Account: This is the bank account from which the campaign check was written.
The default bank account will automatically be listed when you add new transactions.
You may still change this bank account if it does not apply to a specific transaction.
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Forgiven Bills

The Bill Forgiven associated transaction records information when a vendor
forgives part or all of a bill. A forgiven bill is considered to be an in-kind
contribution by the vendor, and it is subject to the contribution and spending
limits and all other rules that govern contributions and expenditures. It can be
accessed by going to the Transactions menu, selecting Bills, choosing the
name and bill that was forgiven, and then adding or selecting a forgiven bill.

When you choose to enter a bill as being forgiven, the following data entry fields will be available
for you to enter information about the associated transactions. After you are done entering
information into a field, you may move to the next field by pressing the [Tab] key or by clicking 
on the next field with your mouse:

• Forgiven Date: This is the date that the vendor forgave the bill.

• Forgiven Amount: This is the amount of the bill that was forgiven.

Bill Payment Refunds

A Bill Payment Refund associated transaction is entered when a vendor
refunds part or all of a bill payment. Bill Payment Refund can be accessed by
going to the Transactions menu, selecting Bills, choosing the name and bill
that was refunded, and then adding or selecting a bill payment refund.

When you choose to enter a bill payment refund, the following data entry fields will be available 
for you to enter information about the refunded payment. After you are done entering information
into a field, you may move to the next field by pressing the [Tab] key or by clicking on the next field
with your mouse:
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• Refund Date: This is the date that the vendor made the refund.

• Refund Amount: This is the amount of the refund.

Entering Transfers Out

The Transfers Out transaction records information about transactions in which money is paid 
by a campaign to a particular type of political committee. Specifically, a transfer out occurs
when money is paid to a party committee, such as a county or state political party. Money paid
to party committees that are not constituted, to candidate committees authorized by another
candidate, or to any other political committee, including a PAC, must be disclosed as a bill and 
bill payment, rather than a transfer. Transfers out, or other payments to political committees, are
not “qualified expenditures,” which means they cannot be paid with public funds. In addition, a
campaign’s amount of matchable contributions will be lowered by the amount of transfers and
other payments to political committees, unless the aggregate amount of those contributions 
does not exceed a specific amount determined by the office sought, or the committee has
established a segregated account for the exclusive purpose of making transfers or payments 
to other committees. For more information on making transfers to other committees, see 
the Campaign Finance Handbook. Transfers out can be accessed by going to the Transactions
menu, selecting Transfers Out, and then selecting the political committee that the transfer is 
being made to.
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When you choose to enter a transfer out, the following data entry fields will be available for you to
enter information about the transfer. After you are done entering information into a field, you may
move to the next field by pressing the [Tab] key or by clicking on the next field with your mouse:

• Committee: This is the campaign committee that made the transfer. The committee you
entered in the Default screen will automatically be listed when you add new transactions.

• Transfer Date: This is the date that the committee made the transfer.

• Transfer Amount: This is the amount of the transfer.

• Bank Account: This is the bank account from which the campaign check was written.
The default bank account will automatically be listed when you add new transactions.
You may still change this bank account if it does not apply to a specific transaction.

• Check Number: This is the check number of the transfer. If the check number exceeds
six digits, you should enter the last six digits of the number in this field.

• Transfer Type:

• Select Type 1 if the transfer is going to a constituted committee, such as a state or county
party committee.

• Select Type 2 if the transfer is going to another committee authorized by the same
candidate but for a different election. If that committee is subject to the rules of the
Campaign Finance Program, you must also enter a transfer in for that committee.
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• Runoff/Rerun: If the transfer was given from a runoff or rerun election account you
should check the box. For more information on runoff or rerun elections please refer 
to the Campaign Finance Handbook.

• Segregated: If money was transferred from the campaign's segregated bank account you
should check the box. For more information about the segregated bank account please
refer to the Campaign Finance Handbook.

Entering Advances

Advancer

An Advancer is someone who spends his or her own money to purchase something on behalf of
a campaign with the expectation of being reimbursed. The Advances transaction screen lists two
different types of transactions. It lists purchases made by an advancer, including information 
about the vendor, and it lists repayments made to reimburse the advancer for his or her purchases.
It can be accessed by going to the Transactions menu and selecting Advances. Until it is repaid,
an advance is considered to be an in-kind contribution by the advancer, and it is subject to the
contribution limit and all other rules that govern contributions. Keep in mind, the CFB considers
all advance repayments to be non-qualified expenditures, meaning public funds cannot be used to
repay advances. The Associated Transaction part of this screen provides access to the Advance
Purchase and Advance Repayment screens.

Entering an advance is a three-
step process. To enter an advance
into C-SMART, you must choose
Advances from the Transactions
menu. This will cause the
Transaction-Name Search screen to
appear. From this screen, you will
select the name of the advancer.
If the individual who made the
advance is not listed on the Name
Search screen, then select Add
Name, which allows you to enter
the advancer's information. After
selecting the advancer, you must
then enter the purchase made by
the advancer, and finally the
repayment by the campaign.
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Purchases

The Purchase associated transaction records information when an advancer spends
his or her money to make a purchase for the campaign with the expectation of being
reimbursed. It can be accessed by going to the Transactions menu, selecting Advances,
choosing the name of the advancer, and then adding or selecting the vendor where the
advance purchase occurred.

When you choose to enter an advance purchase, the following data entry fields will be available for
you to enter information about the purchase. After you are done entering information into a field,
you may move to the next field by pressing the [Tab] key or by clicking on the next field with 
your mouse:

• Advance Date: This is the date that the advance purchase was made.

• Amount: This is the amount of the advance.

• Payment Type: This is used to indicate the method by which the advance was made.

• Purpose Code: You must choose the category that most closely represents the purpose
this advance serves.

• Reason: This field contains a description of the purpose this advance serves.

• Committee: This is the campaign committee on whose behalf the advance was made.
The default committee will automatically be listed when you add new transactions.
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Repayments

The Repayment associated transaction records a campaign reimbursement to
an advancer. It can be accessed by going to the Transactions menu, selecting
Advances, choosing the name of the advancer, and then adding or selecting
advance repayment. Keep in mind, advance repayments are not qualified
expenditures. For more information about qualified expenditures, see the
Campaign Finance Handbook.

When you choose to enter an advance repayment, the following data entry fields will be available
for you to enter information about the repayment. After you are done entering information into a
field, you may move to the next field by pressing the [Tab] key or by clicking on the next field with
your mouse:

• Payment Date: This is the date that the advance repayment was made.

• Amount: This is the amount of the advance repayment.

• Check Number: This is the number of the check written by the campaign.

• Committee: This is the campaign committee that made the repayment. The default
committee will automatically be listed when you add new transactions.

• Bank Account: This is the bank account from which the campaign check was written.
The default bank account will automatically be listed when you add new transactions.
You may still change this bank account if it does not apply to a specific transaction.
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• Runoff/Rerun: If the advance was paid from a runoff or rerun election account you
should check the box. For more information on runoff or rerun elections please refer to
the Campaign Finance Handbook.

• Segregated: If the advance was paid from the campaign's segregated bank account you
should check the box. For more information about the segregated bank account please
refer to the Campaign Finance Handbook.

Entering Information about Your Petty Cash Fund

The Petty Cash Fund transaction lists all deposits to and disbursements from your petty cash fund.
You are not required to enter petty cash disbursements into C-SMART, as long as you keep a paper
petty cash journal instead. However, you must include deposits to the petty cash fund either as Petty
Cash Deposits or as Bills and Bill Payments to the petty cash fund. This screen can be accessed by
going to the Transactions menu and selecting Petty Cash Fund. The associated transaction part of
this screen provides access to the Deposit and Disbursement screens for petty cash. Expenditures
made with petty cash are not qualified expenditures. For more information about qualified
expenditures, see the Campaign Finance Handbook.

Similar to advances, petty cash transactions are a multi-step process. First, you must enter a deposit
into the petty cash fund. For all disbursements from the petty cash fund, you must enter a specific
disbursement.

entering transactions6

chapter 6 | C-SMART v7.0 User Guide56



Petty Cash Deposits

Deposit to Petty Cash records deposits from a campaign to its petty cash
fund. It can be accessed by going to the Transactions menu, selecting Petty
Cash Fund, and then adding or selecting a deposit.

When you choose to enter a deposit to petty cash, the following data entry fields will be available
for you to enter information about the deposit. After you are done entering information into a field,
you may move to the next field by pressing the [Tab] key or by clicking on the next field with 
your mouse:

• Paid Date: This is the date that the deposit was made.

• Paid Amount: This is the amount of the deposit.

• Check Number: This is the number of the check written by the campaign.

• Committee: This is the campaign committee on whose behalf the petty cash fund is
kept. The default committee will automatically be listed when you add new transactions.

• Bank Account: This is the bank account from which the campaign check was written.
The default bank account will automatically be listed when you add new transactions,
unless you change a committee. You may still change this bank account if it does not
apply to a specific transaction.
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Petty Cash Disbursements

Disbursement from Petty Cash records cash payments made by a campaign
using their petty cash fund. It can be accessed by going to the Transactions
menu, selecting Petty Cash Fund, and then adding or selecting a payment.

When you add a new disbursement, C-SMART will bring up an Associated Transaction-Name
Search to identify the name of the vendor from which the purchase is being made.

When you choose to enter a disbursement from petty cash, the following data entry fields will 
be available for you to enter information about the disbursement. After you are done entering
information into a field, you may move to the next field by pressing the [Tab] key or by clicking 
on the next field with your mouse:

• Payment Date: This is the date of the payment.

• Payment Amount: This is the amount of the payment.

• Purpose Code: You must choose the category that most closely represents the purpose of
this disbursement from petty cash.
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Entering Loans

Loans transaction records information about loans received by the campaign. A loan can be
entered by going to the Transactions menu and selecting Loans. If part or all of a loan has been
repaid, the Loan Repayment and Forgiven Loan associated transactions can also be accessed from
this screen.

When you choose to enter a loan, the following data entry fields will be available for you to enter
information about the loan. After you are done entering information into a field, you may move 
to the next field by pressing the [Tab] key or by clicking on the next field with your mouse:

• Date Received: This is the date that the campaign receives the loan.

• Loan Amount: This is the amount of the loan.

• Committee: This is the campaign committee that received the loan. The default
committee will automatically be listed when you add new transactions.

• Bank Loan: Check this box if the loan you have received is from a bank.

• Runoff/Rerun: If the loan was received for a runoff or rerun election account you should
check the box. For more information on runoff or rerun elections please 
refer to the Campaign Finance Handbook.

• Segregated: If the loan was for the campaign's segregated bank account you should
check the box. For more information about the segregated bank account please refer to
the Campaign Finance Handbook.
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• Associated Transaction List: This is a list of all repayments made against this loan, as
well as all forgiven portions of this loan. If no part of this loan has been repaid or
forgiven, it will be blank.

Loan Repayments

The Loan Repayment associated transaction records loan repayments. It can be accessed by going
to the Transactions menu, selecting Loans, choosing the name and loan that was repaid, and then
adding or selecting a loan repayment.

When you choose to enter a loan repayment, the following data entry fields
will be available for you to enter information about the repayment. After you
are done entering information into a field, you may move to the next field by
pressing the [Tab] key or by clicking on the next field with your mouse:

• Paid Date: This is the date that the campaign paid the loan.

• Check Number: This is the number of the check written by the campaign.

• Payment Amount: This is the amount of the payment.

• Bank Account: This is the bank account from which the campaign check was written.
The default bank account will automatically be listed when you add new transactions,
unless you change a committee. You may still change this bank account if it does not
apply to a specific transaction.
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Forgiven Loans

The Forgiven Loan associated transaction records information when a lender
forgives all or part of a loan. A forgiven loan is considered to be a contribution
by the lender, and it is subject to the contribution limit and all other rules that
govern contributions. Forgiven Loans can be accessed by going to the Transactions
menu, selecting Loans, choosing the name and loan that was forgiven, and
then adding or selecting a forgiven loan.

When you choose to enter a forgiven loan, the following data entry fields will be available for 
you to enter information about the forgiven loan. After you are done entering information into a
field, you may move to the next field by pressing the [Tab] key or by clicking on the next field with
your mouse:

• Date Forgiven: This is the date that the lender forgave the bill.

• Amount Forgiven: This is the amount of the loan that was forgiven.

Entering Partnership/Limited Liability Company (LLC) Attributions

If a partnership or LLC contributes more than $2,500, and more than $99 is attributable to a single
partner or member, a Partnership or LLC attribution must be disclosed. The Partnership or LLC
Attributions transaction screen lists all attributions for a particular partnership or LLC. It can be
accessed by going to the Transactions menu and selecting Partnership/LLC Attributions. The
associated transaction part of this screen provides access to the individual attribution records.
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Each individual Partnership or LLC attribution records a specific attribution to a specific partner 
or member. If additional funds need to be attributed to a partner or member, you should add a 
new attribution, rather than editing an existing attribution record. This can be accessed by adding
or selecting a specific attribution record from the main attribution screen. When you add a new
attribution, C-SMART will bring up an Associated Transaction-Name Search to identify the name
of the partner or member to whom the partnership or LLC contribution is being attributed.

When you choose to enter a Partnership or LLC attribution, the following data entry fields will 
be available for you to enter information about the attribution. After you are done entering
information into a field, you may move to the next field by pressing the [Tab] key or by clicking 
on the next field with your mouse:

• Date: This is the date that the attribution was made.

• Attributed: This is the amount that was attributed.

Subcontractors

If a vendor subcontracts more than $5,000 to another vendor, the subcontractor must be disclosed
by entering a Subcontractor transaction. When you select Subcontractors from the Transactions
menu, a list of all your vendors will appear. When you select a vendor from that list, a screen with
all the subcontractor attributions for that vendor will appear.

A subcontractor is disclosed by selecting the Subcontractor transaction from the Transactions
menu. From this, you will select the name of the vendor. This will bring up the
Vendor/Subcontractor screen. For each subcontractor, you must select the Add Subcontract
associated transaction. Each individual Subcontractor screen records information when a vendor
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subcontracts to a service provider. If additional funds need to be subcontracted, you should add a
new subcontractor, rather than editing an existing subcontractor record. A Subcontractor screen can
be accessed by adding or selecting a specific record from the Vendor/Contractor screen. When you
add a new subcontractor, C-SMART will bring up an Associated Transaction-Name Search to
identify the name of the subcontractor to which the vendor is subcontracting.

When you choose to disclose a subcontractor, the following data entry fields will be available 
for you to enter information about the subcontracted transaction. After you are done entering
information into a field, you may move to the next field by pressing the [Tab] key or by clicking 
on the next field with your mouse:

• Date: This is the date that the vendor subcontracted to the provider.

• Amount: This is the amount that the vendor subcontracted to the provider.

• Purpose Code: This is the category that most closely represents the purpose of
subcontracting to the provider.
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Affiliated Groups

The Affiliated Group transaction contains a list of contributors who are affiliated with each other,
such as an individual and a business that he or she owns. Contributions from affiliated contributors
are aggregated and subject to the contribution limit. However, C-SMART does not automatically
provide a warning message if an affiliated group exceeds the contribution limit. Campaigns may
run the Affiliated Contributor Totals report to see the individual and total contributions made by
affiliated contributors.

An affiliated group can be accessed by going to the Transactions menu and selecting Affiliated
Groups. In order to disclose affiliated contributions, you must enter the individual contributions
made by the affiliated contributors in the appropriate contribution screen, create an Affiliated
Group, and indicate membership in the group on each individual Name screen. It does not matter
whether you designate the names as members of the group before or after entering the individual
contributions.

When you choose to create an Affiliated Group, the following data entry fields will be available for
you to enter information about the affiliation. After you are done entering information into a field,
you may move to the next field by pressing the [Tab] key or by clicking on the next field with your
mouse:

• Add a new group by going to the File menu and selecting Add or clicking [Add] on 
the toolbar.

• Modify the group appearing on the screen.
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• Select another group by clicking in the Select Affiliation box and clicking on the 
desired group.

• Go to the Name Search screen by clicking on the [Show Names] button or double-
clicking on a name.

• Save any changes made to the group on screen.

• Delete the group if no names are listed in the affiliation.

• Close the Affiliated Groups screen.

• Go to the Main menu.

The following fields can be modified on the Affiliated Groups screen:

• Affiliation ID: This is a number of up to three digits that you assign to designate 
the group.

• Affiliation Name: This is the name that you assign to the group. It can consist of letters
and numbers. It is recommended that you enter a name that clearly represents the group
for your own recordkeeping. This name is solely for the use of the campaign, and it will
never be publicly disclosed.

• Affiliated Name List: This provides a list that includes every name that has been placed
in this group. Names are added to a group through the Name screen. If no names have
been added to this group, it will be blank.
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The Administration (Admin) menu provides access to various utilities in C-SMART. The following
administrative options are available:

• Security

• Defaults

• Recalculate Totals

• Import Names

• Backup Database

• Restore Database

• Reset Submission Flag

• Recalculate Summary

Security Overview

The Security screen allows you to determine who can gain access to C-SMART and what changes
they are allowed to make.

The Security screen can be accessed by
going to the Admin menu and selecting
Security. This will bring up a User Name
Search screen that lists everyone who has
access to C-SMART.

When using the User Name Search screen,
you may perform the following actions:

• Click once on a specific name record
to highlight it.

• Use the Search box to narrow the list 
of names or search for a specific name.



• Click the [Select] button to bring up the security screen for the highlighted name record.
Unlike other search screens, you cannot add a new name from this screen. You should
select an existing name and add a new name from there.

• Click the [Close] button to close the screen.

Adding and Editing a User

The following functions may be performed to add or edit the C-SMART user profile from the
Security screen:

• Add a new user by going to the File menu and selecting Add or clicking [Add] on the
toolbar.

• Modify the user on screen.

• Delete the user on screen.

• Close the Security screen.

• Cancel any changes that have been made to the user on screen.

• Save any changes that have been made to the user on screen.

• Go to the Main Menu.

The following fields can be edited when adding or editing a C-SMART user:

• Last Name: This is the last name of the person who can access C-SMART.

• First Name: This is the first name of the person who can access C-SMART.

• User ID: This is the unique ID that the person will enter on the login screen in order to
gain access to C-SMART.

• User Password: This is the password that the user will enter on the login screen in order
to gain access to C-SMART. The password is encrypted. If you forget your password,
you will need to bring a copy of your database to the CFB in order to regain access to
C-SMART. When you actually enter a password, you will be required to re-enter it in
order to ensure that you have not made any typographical errors.

• Class: This determines the level of access that the user has to C-SMART.

— Read-Only: A user with this level of access may view all information and run all
reports in C-SMART. This user may not make any changes to the database. This 
user also may not run Submissions or modify the Security screen.
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— Data Entry: A user with this level of access may add or modify campaign, name, and
transaction information, and run all reports in C-SMART. This user may not run
Submissions or modify the Security screen.

— Submit: A user with this level of access may add or modify campaign, name, and
transaction information, run all reports in C-SMART, and run Submissions or
Amendments. This user may not modify the Security screen.

— Full Access: A user with this level of access has full access to all functionality in 
C-SMART, including Security. If someone else forgets his or her password, a user 
with this level of access may change it. However, this user may not modify his or her
own security class.

Please note: (1) User ID, Class, and Expiration Date may not be modified for the “ADMIN”
user or for the user who is currently signed into C-SMART. (2) The “ADMIN” user may
not be deleted.

• Expiration Date: This is the date on which this user will lose access to C-SMART. The
candidate and treasurer are required to keep all records related to compliance with the
Program for at least six years after the election; thus, the campaign should retain access
to C-SMART for at least that time period.

Defaults

See pages 21-22.

Recalculating Totals

Recalculate Totals is used to recalculate all the transaction totals that are kept in C-SMART.
It should be used if the numbers in the various total boxes in C-SMART appear to be inaccurate,
possibly resulting from a computer crash while you are using C-SMART.

The Recalculate Totals screen can be accessed from the Main menu by going to the Admin menu
and selecting Recalculate Totals.
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The following functions may be performed from the Recalculate Totals screen:

• Begin the recalculation process by clicking the [Start] button or
going to the File menu and selecting Start. You will be given a
prompt asking you whether you wish to continue. Another prompt
will inform you when the process has been completed.

• Close the Recalculate Totals screen.

Convert Names to Upper and Lower Case

When you restore a database into C-SMART, or when you import
names, the names will automatically be converted into upper and lower
case. If this does not happen, or there is an error during the process,
you can run this function to attempt to correct the problem.

Importing Names

The Import Names function brings name records from a prior election cycle into the current
version of C-SMART. This utility can be run at any time. We recommend you run it before entering
data into C-SMART. Running the utility after you have entered data into C-SMART may result in
duplicate name records in C-SMART. If the utility is run after you have entered data into C-SMART,
you should use the Name List Report to find any duplicate names before you enter additional data.
You should delete the duplicate name record that has no transactions associated with it. Use the
Transaction List on the Name Maintenance screen to find out if a name record has transactions
associated with it.

The Import Names function can be accessed from the Admin menu.

If you have previously filed disclosure statements with the CFB an Import Names file should have
been included on your C-SMART installation CD. This will transfer the names of all the individuals
and entities (contributors, vendors, etc.) involved with your campaign during the previous election.
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Please remember you must check all name and address information to ensure that the name
information is up-to-date and correct, and to eliminate any duplicate names. To avoid errors,
the Council District Resident box has been blanked out for all names. If you are running for City
Council, it is important to re-check this box.

You can use the Name List Report and Transaction List (in the Name Maintenance screen) to check
the information. If you have previously filed with the CFB, and have not been provided with an
Import Names file, please call the Candidate Services Unit before entering data into C-SMART.

The following functions may be performed from the Import Name screen:

• Click on the [Proceed] button to import names from the CFB name file into C-SMART.

• Close the Import Names screen.

Backing Up Your Database

The Back Up Database function allows you to backup your C-SMART data.

Why and when should you backup your database?

• If a problem occurs with your computer, i.e., the hard drive crashes or becomes infected
with a virus, or C-SMART is accidentally uninstalled, you are protected because you have
a copy of all the information that has been entered into C-SMART.

• To provide a snapshot of your database before a submission is run. Once you run a
submission, C-SMART makes permanent alterations to the database.

• Whenever you need to move C-SMART to another computer.

It is strongly recommended that:

• You backup your data frequently.

• You keep more than one copy of each backup. (This way if something goes wrong with
one backup, you will not lose too much information by restoring a previous backup.)

• You make and keep a permanent backup of your data immediately before and after 
each final submission and final amendment that you make to the CFB and the BOE.
(The submission and amendment processes make several irreversible changes to your
data. If anything goes wrong, it may be helpful to be able to restore the data that does
not contain those changes.)

You may backup your data to any medium, including floppy disks, a CD-ROM, zip disks, or in a
directory on your hard drive. If you backup your data to your hard drive, make sure that you select
a directory that is not used for any other purpose. Even if you keep most of your backups on your
hard drive, it is recommended that you periodically backup your data to another medium in case
you have a hard drive failure.
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If you backup your data onto a floppy disk, C-SMART will delete anything that was previously
saved on that disk. Make sure you use a new disk or one that does not contain files you need.
C-SMART will not delete files when backing up data to any other medium, although it will
overwrite previous backups if they have been saved in the same place.

The Backup Database screen can be accessed from the Main menu by going to the Admin menu
and selecting Backup Database.

How to Backup Your Database

We recommend that you backup your database on a diskette. Insert a blank disk into the A Drive of
your computer. Click on the dropdown arrow in the Drives box. Select Drive A (-a-) and click Ok.
You also have the option of backing up your database to another drive.

Perform the backup once the directory has been selected by clicking on the [Proceed] button. C-
SMART executes the WINZIP program to perform and track the progress of the Backup process.
When creating a backup of your database, the WINZIP program provides a warning message
informing the user that this utility will delete all files on the disk. To proceed, click [Yes].
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After the WINZIP screen closes, C-SMART will perform some additional processing, followed by a
screen informing you that the backup is completed. Clicking the [OK] button will end the process.

• Close the Backup Database screen.

• Go to the Main menu.

Restoring Your Database

The Restore Database function allows you to restore your C-
SMART data from a backup database. If you are having
problems restoring your database, call the Candidate Services
Unit at (212) 306-7100.

Restoring your data will delete anything that has currently been saved in C-SMART and replace
it with the data from your backup. You will lose any transactions that you have entered since
performing the backup from which you are restoring data.

The Restore screen can be accessed from the Main menu by going to the Admin menu and selecting
Restore Database.

The following steps should be followed to restore your database:

• Select the source where your backup is saved by clicking on the 
[Browse] button.
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• Perform the restoration by clicking on the [Proceed] button. C-SMART executes the
WINZIP program to perform and track the progress of the restore
process.

After the WINZIP screen closes, C-
SMART will perform some additional
processing, followed by a screen
informing you that the database is
restored. Clicking the [OK] button will
end the process.

• Close the Restore screen.

If you are restoring a database from an older version of C-SMART, that
data will need to be upgraded to Version 7.0. You will be prompted with
a message informing you that the database will be updated. Following
this, C-SMART will automatically restart to complete the process. The
entire process can take a few minutes, depending on the speed of your
computer and the amount of information in your database. Once the
update is complete you will be at the login screen and your database 
will be restored.

Reset Submission Flag

The Draft and Final Submission and Amendment processes in C-SMART use specific records in
the software to generate disclosure statements and the submission diskette. When someone starts 
to run Submission or Amendment, C-SMART places a flag in the database that prevents anyone
else from activating Submission or Amendment. The flag is cleared after the Submission or
Amendment process is complete so that both processes can be activated again when they are next
needed.

If a problem occurs with your computer while you are running a submission or amendment, such
as a C-SMART crash, computer crash, or power interruption, C-SMART will be unable to complete
the process. In these situations, the flag that prevents more than one person from activating those
processes may remain in place. Reset Submission Flag clears this flag so that the Submission and
Amendment processes can again be accessed.

Please make sure that no one else is logged into C-SMART and no one is generating a draft or
final submission or a draft or final amendment in C-SMART before running Reset Submission
Flag. Running Reset Submission Flag while someone else is using C-SMART risks crashing the
application and permanently damaging your data.

The Reset Submission Flag screen can be accessed from the Main menu by going to the Admin
menu and selecting Reset Submission Flag.

The following functions may be performed from the Reset Submission Flag screen:
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• Reset the submission flag by clicking on the [Proceed]
button. You will be required to click [Yes] at the warning
prompt in order for the flag to be reset.

• Close the Reset Submission Flag screen.

Recalculate Summary

Recalculate Summary is used to recalculate the summaries that are kept in C-SMART. Recalculate
Summary starts recalculating with the opening numbers in each committee’s first C-SMART
disclosure statement. Please make sure that these opening numbers are accurate before running
Recalculate Summary. Recalculate Summary should be used if any of the summary numbers in
any of the statements in C-SMART appear to be inaccurate, possibly resulting from a computer
crash while you are using C-SMART, or running multiple amendments for the same disclosure
statement.

The Recalculate Summary screen can be accessed from the Main menu by going to the Admin
menu and selecting Recalculate Summary.

The following functions may be performed from the Recalculate Summary screen:
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• Begin the recalculation process by clicking the [Start] button or going to the File menu
and selecting Start. You will be given a prompt asking you whether you wish to continue.
Another prompt will inform you when the process has been completed.

• Close the Recalculate Summary screen.

• Go to the Main menu.
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C-SMART has a variety of different reports which allow a campaign to review different aspects of a
campaign’s financial activity. The reports which C-SMART provides are:

• Name List

• Itemized Contributions

• Contributor Totals

• Total Fundraising

• Affiliated Contributor
Totals

• Intermediary Totals

• Intermediated Contributors

• Itemized Expenditures

• Total Expenditures

• Outstanding Advances

• Outstanding Bills

• Advance Recordkeeping

• Petty Cash Journal

• Check Register

• Cash Flow

• Threshold

• Invalid Matching Contributions/Potential Compliance Problems

• Modified Statement

All reports can be accessed by going to the Reports menu and selecting the desired report.
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Navigating Reports

The following functions may be performed from all report screens:

• Run the report by clicking on the [Run] button.

• Access the Printer Setup screen by going to the File menu and
selecting Printer Setup or clicking the [Printer Setup] button
on the toolbar.

• After running the report, you may print the report by going to
the File menu and selecting Print or clicking the [Print] button
on the toolbar. This will bring up the Print Options screen,
which allows you to print the entire document or designate
specific pages to be printed.

• Select a different report by going to the Reports menu.

• Close the Report screen.

• Access the Main menu from the File menu.
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Viewing a Report

There are several different ways to view a report:

• View the entire report by going to the View menu and selecting Print
Preview or clicking the [Print Preview] button on the toolbar.

• Magnify part of the report by going to the View menu and selecting Zoom
or clicking the [Zoom] button on the toolbar.

• View the first page by going to the View menu and selecting First Page or
clicking the appropriate button on the toolbar.

• View the previous page by going to the View menu and selecting Prior Page
or clicking the appropriate button on the toolbar.

• View the next page by going to the View menu and selecting Next Page or
clicking the appropriate button on the toolbar.

• View the last page by going to the View menu and selecting Last Page or
clicking the appropriate button on the toolbar.

Additional Reports Tools

In addition, many reports include one or more of the following options:

• Selection Criteria: This sets criteria that limit the results generated by the report.
Prior to running the report, each criterion must be assigned a particular value or range,
or the All box must be selected for it. See each report for the selection criteria available.

• [Save As] button: This allows you to save the data that the report generates in a database
(.dbf) or Microsoft Excel (.xls) format. This data can be used in word processing,
spreadsheet, or database applications for purposes including tracking information and
preparing mailings using a mail merge. When you click the button, you will be asked to
select the type of file (.dbf or .xls), indicate where you want the file saved, and provide a
name for the file. Please note that some of the information contained in the saved .dbf
or .xls file may not be visible on the report as it is printed or viewed on screen.
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Order By

The Order By menu is available from most report screens. It allows you to choose different ways 
to sort the information in a report. Specific information about the available sort orders, if any, is
provided in the description of each report below.

Creating a Mail Merge

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By using the [Save As] function available in most
reports, you can save a report as a database (.dbf) or Excel (.xls) file for use in a spreadsheet
program. Most word processors have their own mechanism for performing mail merges, and most
database packages allow you to customize your own reports to perform mailings. Please consult
your word processor software documentation for more information on how to create a mail merge.

Running a Report

Using C-SMART to generate or run a report is a fairly simple process. The following steps will walk
you through how to have C-SMART run a report for you.

• Select a report from the Reports menu.

• In the Selection Criteria box, choose which information you would like retrieved for the
report. If you would like all applicable information, click in the “All” box.

• Click the [Run] button.
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• The report you requested will appear on the screen. Should you wish to view other
pages, you may do so by clicking on the [Prior] or [Next] page buttons on the toolbar.

• If you wish to go back to the main report screen in order to change your selection
criteria, you should click on either the [Print Preview] toolbar button or select Print
Preview from the View menu.

C-SMART Reports

Name List Report

The Name List report provides a list of names in C-SMART. This report does not differentiate
between names for which transactions have been entered and names that have no associated
transactions. It provides information for every name record that has been entered into C-SMART.

Selection Criteria

• Name Code: This limits the report to a specific type of name (i.e., Individual,
Corporation, etc.).

Order By

• Name: This sorts by name.

• Contact Name: This sorts by the contact name associated with the name record.
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• Employer Name: This sorts by the employer name of the individual.

• Street Name: This sorts by the street name and then by the street number to locate
similar addresses.

• Borough Code: This sorts the name records by borough.

• City: This sorts the name records by city.

• State: This sorts the name records by state.

• Name Status: This sorts the name records by their name status - Active, Inactive, or On-Hold.

Exporting Data

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By clicking on the [Save As] button in this report,
you can generate a database (.dbf) or Excel (.xls) file which you can use to provide the data for a 
mail merge.

Itemized Contributions Report

The Itemized Contributions report provides a list of all itemized contributions received by the
campaign. The list may be limited to monetary contributions, or it may include all contributions:
monetary contributions, in-kind contributions, Type 1 transfers in, forgiven bills, forgiven loans,
and advance purchases.
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Selection Criteria

• Date: This limits the report to a range of selected dates.

• Amount: This limits the report to a range of selected minimum (greater than or equal to)
and maximum (less than or equal to) contribution amounts.

• Matchable Amount: This limits the report to a range of selected minimum (greater than
or equal to) and maximum (less than or equal to) matchable claim amounts.

• Contribution Type: This limits the report to Monetary Contributions only.

• Exclude Advances: If you do not want to include Advances then check this box.

• Name Code: This limits the report to a specific type of name (i.e. Individual, Partnership).

• Runoff/Rerun: This limits the report to Runoff/Rerun contributions when checked.

• Segregated: This limits the report to Segregated contributions when checked.

Order By

• Name: This sorts by the name of the contributor.

• Amount: This sorts by the dollar amount of the transaction (from the smallest to the largest).

• Matchable Amount: This sorts by the matchable amount of the contribution.

• Date: This sorts by the transaction date.

• Contact Name: This sorts by the contact name associated with the name record.

• Employer Name: This sorts by the employer name of the contributor.

• Street Name: This sorts by the street name and then by the street number to locate similar addresses.

• Borough Code: This sorts by the borough the contributor lives in.

• City: This sorts by the city the contributor lives in.

• State: This sorts by the state the contributor lives in.

• Optional Info About Contribution: This sorts by the optional info about a contribution field,
shown on the report as "Source:".

• Transaction Number: This sorts by the transaction number of the transaction.

• Residency Indicator: This sorts by district residents and non-district residents.

• Runoff/Rerun: This sorts by the runoff/rerun and segregated indicators.

Exporting Data

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By clicking on the [Save As] button in this report, you
can generate a database (.dbf) or Excel (.xls) file which you can use to provide the data for a mail
merge.

reports 8

C-SMART v7.0 User Guide | chapter 8 83



Contributor Totals Report

The Contributor Totals report provides a list of contributors and the total amount that they have
contributed. It does not provide information about itemized contributions, which can be found 
on the Itemized Contributions report. The Contributor Totals report includes the total value of
all monetary contributions, prior contribution amounts, in-kind contributions, Type 1 transfers 
in, forgiven bills, forgiven loans, partnership attributions, and unreimbursed advances with the
total amount of contribution refunds subtracted. This report can be used to determine if an 
entity has contributed the maximum amount allowed.

Selection Criteria

• Amount: This limits the report to a range of selected minimum (greater than or equal to)
and maximum (less than or equal to) total contribution amounts.

• Amount Less Than Contribution Limit: When checked, the report will list only
contributors who have contributed less than the contribution limit for the office selected
on the Candidate Screen.

• Matchable Amount: This limits the report to a range of selected minimum (greater than
or equal to) and maximum (less than or equal to) total matchable claim amounts.

• Matchable Amount Less than Matchable Limit: When checked, the report will list only
contributors whose matching claims are less than the matching claims limit.

• Name Code: This limits the report to a specific type of name (i.e. Individual,
Partnership).

• Individuals Only: When checked, the report will list only contributors that are entered
as individuals (IND, CAN, SPO, FAM).
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Order By

• Name: This sorts by the name of the contributor.

• Amount: This sorts by the dollar amount of the contribution total (from the smallest to
the largest).

• Matchable Amount: This sorts by the total matchable amount claimed for the contributor.

• Contact Name: This sorts by the contact name associated with the name record.

• Employer Name: This sorts by the employer name of the contributor.

• Street Name: This sorts by the street name and then by the street number to locate
similar addresses.

• Borough Code: This sorts by the borough the contributor lives in.

• City: This sorts by the city the contributor lives in.

• State: This sorts by the state the contributor lives in.

• Name Status: This sorts by the name status of the contributor - Active, Inactive, or On-Hold.

Exporting Data

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By clicking on the [Save As] button in this report,
you can generate a database (.dbf) or Excel (.xls) file which you can use to provide the data for a 
mail merge.

Total Fundraising Report

The Total Fundraising report totals the dollar value of different types of contributions, including
monetary and in-kind contributions, Type 1 and Type 2 transfers in, forgiven loans and liabilities,
unreimbursed advances, contribution refunds, and other receipts (loans, public funds payments,
etc.). It does not itemize individual contributions, which can be examined using the Itemized
Contributions report. It also does not provide totals for individual contributors, which can be
found on the Contributor Totals report.
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Selection Criteria

This report has no selection criteria. It provides the total for each type of contribution, the gross
contributions total, the net contributions total, and the total receipts.

Order By

This report has no sort orders.

Affiliated Contributor Totals Report

The Affiliated Contributor Totals report lists each affiliated group. For each group, it indicates the
total contributed by each member and the total contributed by the entire group. These totals are
adjusted to account for refunds or other adjustments. Contributions from affiliated contributors 
are aggregated and subject to the contribution limit. However, C-SMART does not automatically
provide a warning message if an affiliated group exceeds the contribution limit. This report can be
used to access that information.

Selection Criteria

This report has no selection criteria. Every contributor for each affiliated group will be listed.

Order By

• Group ID: This sorts by the Affiliated Group ID.
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Intermediary Totals Report

The Intermediary Totals report provides a list of intermediaries and the total amount that they 
have intermediated. It does not provide information about individual contributions or individual
contributors. That information is available on the Intermediated Contributions report.

Selection Criteria

This report has no selection criteria. All intermediaries are included.

Order By

• Amount: This sorts by the total dollar amount intermediated.

• Matchable Amount: This sorts by the total amount of matchable claims for
intermediated contributions.

• Intermediary Name: This sorts by the name of the intermediary.

• Contact Name: This sorts by the contact name associated with the name record.

• Employer Name: This sorts by the employer name of the intermediary.

• Street Name: This sorts by the street name and then by the street number to locate
similar addresses.

• Borough Code: This sorts by the intermediary’s borough code.

• City: This sorts by the intermediary’s city.

• State: This sorts by the intermediary’s state.
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Exporting Data

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By clicking on the [Save As] button in this report,
you can generate a database (.dbf) or Excel (.xls) file which you can use to provide the data for a 
mail merge.

Intermediated Contributions Report

The Intermediated Contributions report provides a list of intermediated contributions, including
information on the intermediaries and the contributors.

Selection Criteria

• Date: This limits the report to a range of selected dates.

• Amount: This limits the report to a range of selected minimum (greater than or equal to)
and maximum (less than or equal to) intermediated contribution amounts.

• Name Code: This limits the report to a specific type of contributor (i.e. Individual, Partnership).

Order By

• Contributor Name: This sorts by the name of the contributor.

• Amount: This sorts by the dollar amount of the contribution.

• Matchable Amount: This sorts by the matchable amount of the contribution.

• Date: This sorts by the transaction date.

• Intermediary Name: This sorts by the name of the intermediary.
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• Contributor Contact Name: This sorts by the contributor contact name associated with
the name record.

• Contributor Employer Name: This sorts by the contributor employer name.

• Contributor Street Name: This sorts by the contributor street name and then by the
street number to locate similar addresses.

• Contributor Borough Code: This sorts by the borough the contributor lives in.

• Contributor City: This sorts by the city the contributor lives in.

• Contributor State: This sorts by the state the contributor lives in.

Exporting Data

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By clicking on the [Save As] button in this report,
you can generate a database (.dbf) or Excel (.xls) file which you can use to provide the data for 
a mail merge.

Itemized Expenditures Report

The Itemized Expenditures report provides a list of campaign expenditures. Expenditures include
in-kind contributions, bills, and, Type 1 transfers out.

Selection Criteria

• Date: This limits the report to a range of selected dates.

• Amount: This limits the report to a range of selected minimum (greater than or equal to)
and maximum (less than or equal to) expenditure amounts.

• Exempt Code: This limits the report to a specific type of exemption.

• Name Code: This limits the report to a specific type of name (i.e. Individual, Partnership).
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Order By

• Name: This sorts by the name of the vendor.

• Amount: This sorts by the dollar amount of the transaction.

• Date: This sorts by the transaction date.

• Borough Code: This sorts by the vendor’s borough code.

• City: This sorts by the vendor’s city.

• State: This sorts by the vendor’s state.

• Purpose Code: This sorts by the purpose description of the transaction.

• Exempt Code: This sorts by the exemption description of the transaction.

• Runoff/Rerun: This sorts by the runoff/rerun and segregated indicators.

Exporting Data

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By clicking on the [Save As] button in this report,
you can generate a database (.dbf) or Excel (.xls) file which you can use to provide the data for a 
mail merge.

Total Expenditures Report

The Total Expenditures report totals the dollar value of different types of expenditures, including
advances, expenditure payments, in-kind contributions, outstanding liabilities, Type 1 transfers out,
petty cash deposits, and expenditure refunds. Separate columns total exempt and non-exempt
expenditures. It does not itemize individual expenditures, which can be found by running the
Itemized Expenditures report.
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Selection Criteria

• Date: This limits the report to a range of selected dates.

Order By

This report has no sort orders.

Outstanding Advances

The Outstanding Advances report provides a list of all advances that are still outstanding.
Advances are considered to be contributions from the advancer until repaid. Immediately repay 
any outstanding advances that when added to previous contributions from the advancer, cause 
the advancer to exceed the contribution limit.

Selection Criteria

• Amount: This limits the report to a range of selected minimum (greater than or equal to)
and maximum (less than or equal to) outstanding advance amounts.

Order By

• Name: This sorts by the name of the advancer.

• Amount: This sorts by the dollar amount of the outstanding advance.

• Borough Code: This sorts by the advancer’s borough code.
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Exporting Data

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By clicking on the [Save As] button, you can generate 
a database (.dbf) or Excel (.xls) file which you can use to provide the data for a mail merge.

Outstanding Bills Report

The Outstanding Bills report lists unpaid and partially paid bills. Bills are considered to be
expenditures when they are incurred, and are thus counted toward the campaign’s expenditure 
limit even if they have not yet been paid.

Selection Criteria

• Date: This limits the report to a range of selected dates.

• Amount: This limits the report to a range of selected minimum (greater than or equal
to) and maximum (less than or equal to) outstanding bill amounts.

Order By

• Name: This sorts by the vendor name.

• Amount: This sorts by the dollar amount of the outstanding bill.

• Date: This sorts by the transaction date.

• Borough Code: This sorts by the vendor’s borough code.
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Exporting Data

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By clicking on the [Save As] button in this report,
you can generate a database (.dbf) or Excel (.xls) file which you can use to provide the data for a 
mail merge.

Advance Recordkeeping Report

The Advance Recordkeeping report maintains records of advance purchases and repayments made
on behalf of the campaign. Campaigns are required to keep all receipts and other documentation
for advances.

Selection Criteria

• Date: This limits the report to a range of selected dates.

• Amount: This limits the report to a range of selected minimum (greater than or equal
to) and maximum (less than or equal to) advance purchase and repayment amounts.

Sort Order

• Name: This sorts by the name of the advancer.

• Amount: This sorts by the dollar amount of the transaction.

• Date: This sorts by the transaction date.

• Borough Code: This sorts by the advancer’s borough code.
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Exporting Data

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By clicking on the [Save As] button in this report,
you can generate a database (.dbf) or Excel (.xls) file which you can use to provide the data for a 
mail merge.

Petty Cash Journal

The Petty Cash Journal report lists deposits to and disbursements from the petty cash fund,
including all information that campaigns would otherwise be required to maintain on paper in 
a petty cash journal. Campaigns are required to keep all receipts and other documentation for
expenditures made with petty cash.

Selection Criteria

• Date: This limits the report to a range of selected dates.

Order By

This report has no optional sort orders. By default, it is sorted by date.
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Check Register

The Check Register report lists checks disbursed by the campaign, including bill payments, advance
repayments, transfers out, loan repayments, and contribution refunds.

Selection Criteria

• Date: This limits the report to a range of selected dates.

Order By

• Payee Name: This sorts by the name of the payee.

• Amount: This sorts by the transaction amount.

• Date: This sorts by the payment date.

• Original Date: This sorts by the date of the invoice.

• Transaction Type: This sorts by the type of transaction.

• Check Number: This sorts by the check number.

Exporting Data

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By clicking on the [Save As] button in this report,
you can generate a database (.dbf) or Excel (.xls) file which you can use to provide the data for 
a mail merge.
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Cash Flow Report

The Cash Flow report categorizes monies received by the campaign and compares them against
monies disbursed by the campaign. The difference results in a Net Cash Flow total. The following
transaction types are counted as cash received: Monetary Contributions, Transfers In, Other
Receipts, Loans Received and Expenditure Refunds. The following transaction types are considered
to be cash disbursed: Bills Paid, Advance Repayments, Petty Cash Deposits, Transfers Out, Loan
Payments, Monetary Contribution Refunds and Public Funds Repayments.

For more information on accessing or using this screen, see the help for Reports in C-SMART.

Selection Criteria

This report has no selection criteria.

Order By

This report has no sort orders.

Threshold Report

The Threshold report estimates the campaign’s progress toward meeting both parts of the threshold
for receiving public matching funds. It lists the total number of contributors and the dollar amount
required to meet the threshold for the office sought (as entered in the Candidate screen). It then
shows the number of contributors that you indicated are residents and who meet the residency and
minimum contribution threshold requirements, and the dollar amount contributed by New York
City residents. It then lists the number of contributors and the dollar amount that C-SMART has
preliminarily identified as valid for the threshold requirements.
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C-SMART considers a contribution invalid if the contributor has exceeded either the CFB
contribution limit or the New York State cash contribution limit, if the contribution was received
outside of the election cycle, if incomplete address information has been provided for the contributor,
or if incomplete employment information has been provided for a contributor who gave more than
$99. If a contributor has given more than $100, his or her contributions may still be matchable if
the campaign has documented and submitted its best efforts to secure employment information.

C-SMART does not perform numerous
other tests that are relevant for determining
whether a matching claim or threshold
calculation is valid. This report is available
merely to give you guidance on your
progress toward meeting the threshold.
The CFB will make the final determination
regarding when you have met the threshold
and are otherwise eligible to receive public
matching funds.

Selection Criteria

This report has no selection criteria.

Sort Order

This report has no sort orders.

Invalid Matching Contributions and Other Potential Compliance Problems Report

The Invalid Matching Contributions and Other Potential Compliance Problems report lists
contributions that C-SMART has identified as invalid for the purpose of receiving public matching
funds. Some of these contributions may also violate the rules of the Program, requiring that they be
refunded as quickly as possible.

C-SMART considers a contribution invalid if the contributor has exceeded either the CFB
contribution limit or the New York State cash contribution limit, if the contribution was received
outside of the election cycle, if incomplete address information has been provided for the
contributor, or if incomplete employment information has been provided for a contributor who
gave more than $99.

C-SMART does not perform the numerous other tests performed by the CFB that are relevant 
for determining whether a matching claim is valid. The CFB will make the final determination
regarding whether a matching claim is valid.

Selection Criteria

• Invalid Reason: This limits the report to a specific type of invalid matching contribution.

• Matching Claims Only: When checked, the report will list only matching claims.

reports 8

C-SMART v7.0 User Guide | chapter 8 97



Order By

• Name: This sorts by contributor name.

• Date: This sorts by contribution date.

• Invalid Reason: This sorts by the type of invalid matching contribution.

• Transaction ID: This sorts by the Transaction ID number.

• Borough Code: This sorts by the borough code of the contributor.

• City: This sorts by the city the contributor lives in.

• State: This sorts by the state the contributor lives in.

• Residency Indicator: This sorts by district residents and non-district residents.

Exporting Data

A mail merge is used to add a list of names and addresses (data file) to a prepared letter or labels
(form) file to create a personalized mailing. By clicking on the [Save As] button in this report,
you can generate a database (.dbf) or Excel (.xls) file which you can use to provide the data for a 
mail merge.
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Modified Statement Report

The Modified Statement report provides a list of transactions that have been modified or deleted
since the last time the submission process was run for that disclosure statement. Transactions that
appear on this report appear by committee and then by statement.

Selection Criteria

This report has no selection criteria.

Order By

This report has no sort orders.

Report Legend

When outputting the information from the various reports into a database (.dbf) or (.xls) file, the
abbreviations shown below are used.

Column Header Description of Contents

ACCTNO Account Number

ADVANCER_AMNT Total Purchases

ADVPAY_AMNT Total Repayments

reports 8

C-SMART v7.0 User Guide | chapter 8 99



Column Header Description of Contents

ADVANCER-A Total Advanced by Advancer

ADVPAY-AMN Amount Repaid to Advanced

ADVREFNO Advance Transaction Reference Number

AMNT Amount of Transaction

AMOUNT Amount of Transaction

APARTMENT Apartment Number

BANKNM Bank Name

BILLAMOUNT Bill Amount

BOROUGHCD Borough Code

C_CODE Name Code

CACCTID Account ID (for CFB Processing Only)

CFIELD Comment Field

CHECKNO Check Number

CINREFNO Intermediate Reference Number

CITY City

COMMITTEE Committee ID

CONTACT Contact Name

EMAIL E-mail Address

EMPAPTNO Employer Apartment Number

EMPCITY Employer City

EMPNAME Employer Name

EMPSTATE Employer State

EMPSTRNAME Employer Street Name

EMPSTRNO Employer Street Number

EMPZIP Employer Zip code (5 digits)

EMPZIP2 Employer Extended Zip code (4 digits)

EXEMPT Exempt Code

FAX Fax Number
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Column Header Description of Contents

FIRSTNM First Name

FORMAL Formal Name

IAPARTMENT Intermediary’s Apartment Number

IBOROUGH Intermediary’s Borough Code

ICITY Intermediary’s City

ICODEID Name Code

ICONTACT Intermediary’s Contact Name

IEMAIL Intermediary’s E-mail Address

IEMPAPTNO Intermediary’s Employer 
Apartment Number

IEMPCITY Intermediary’s Employer City

IEMPNM Intermediary’s Employer Name

IEMPSTATE Intermediary’s Employer State

IEMPSTRNM Intermediary’s Employer Street Name

IEMPSTRNO Intermediary’s Employer Street Number

IEMPZIP Intermediary’s Employer Zip code 
(5 digits)

IEMPZIP2 Intermediary’s Employer Extended 
Zip code (4 digits)

IFAX Intermediary’s Fax Number

IFINM Intermediary’s First Name

IFORMALN Intermediary’s Formal Name

IJOB Intermediary’s Occupation

ILANM Intermediary’s Last Name

IMINM Intermediary’s Middle Name

INTNO Intermediary Number

INVALID Reason Amount Invalid

INVDATE Invoice Date

IPHONE Intermediary’s Phone Number
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Column Header Description of Contents

IPHONEEXT Intermediary’s Phone Number Extension

ISALUT Intermediary’s Formal Greeting

ISTATE Intermediary’s State

ISTRNAME Intermediary’s Street Name

ISTRNO Intermediary’s Street Number

IZIP Intermediary’s Zip code (5 digits)

IZIP2 Intermediary’s Zip code Extended 
(4 digits)

LASTNM Last Name

LRESIND Residency Indicator

M_AMT Matchable Amount

MATCHAMNT Matchable Amount

MDATE Itemized Contribution Date

MIDDLE Middle Name

NATCHAMNT Matchable Amount

OCCUPATION Occupation

ORIG_DATE Original Transaction Date

OUTSTANDIN Outstanding Amount

PDATE Advance Date

PHONE Phone Number

PHONEEXT Phone Number Extension

PURPOSE Purpose Code

PURPS Purpose Code

RDATE Date Received

REASON Suggested Course of Action

REFNO Reference Number

RUNOFF-RER Runoff/Rerun Indicator (Y/N)

SALUT Formal Greeting

SEGREGATED Segregated Indicator (Y/N)
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Column Header Description of Contents

SOURCE Optional Info About Contribution

SOURCE Source of Intermediary Contribution

STATE State

STRNAME Street Name

STRNO Street Number

TRANSID Transaction ID Number

TRANSTYPE Transaction Type

VAPTNO Vendor’s Apartment Number

VCITY Vendor’s City

VFIRST Vendor’s First Name

VLAST Vendor’s Last Name

VMIDDLE Vendor’s Middle Name

VREFNO Vendor’s Reference Number

VSTATE Vendor’s State

VSTRNAME Vendor’s Street Name

VSTRNO Vendor’s Street Number

VZIP Vendor’s Zip Code

ZIP Zip code (5 digits)

ZIP2 Zip code Extended (4 digits)
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There are three types of filings for public disclosure:

1. Submissions: These generate a complete set of disclosure forms for an entire disclosure
statement period.

2. Amendments: These generate a limited set of disclosure forms for an entire disclosure
statement and a Cross-Reference report. The Cross-Reference report itemizes all changes
made since the last submission or amendment of that disclosure statement.

3. Pre-Election Disclosure: This creates the Daily Pre-Election Disclosure statement.
In the 14 days preceding an election, you must disclose all contributions and loans from
a single source in excess of $1,000 and expenditures made in excess of $20,000. This
information must be disclosed to the CFB within 24 hours after the listed contributions
and loans are accepted or the expenditures are made.

These three filings can be generated from the Submission menu. The Submission menu provides
access to the Disclosure Statement screens for generating draft and final submissions, and
amendments for the CFB and the BOE. The Submission menu also provides you with access to 
the Contemporaneous Pre-Election Disclosure Statement, which may be required by the CFB in
certain circumstances.
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For Prior Filings without C-SMART

If you have filed disclosure statements without using C-SMART, you must enter all previously
disclosed transactions into C-SMART for each disclosure statement that was previously filed with
the CFB before any subsequent filings are made. This will enable C-SMART to more accurately 
and completely reflect the current status of the campaign. In order to do this, please complete the
following steps:

1. Enter all previously disclosed transactions into C-SMART.

2. Run a submission for all previously submitted disclosure statements in order. You must
complete this step before making any subsequent filings. Otherwise, transactions will 
be included in incorrect filing periods.

3. Keep the disks and paper for your records. Do not submit them to the CFB.

If you do not go back and enter all previous data into C-SMART, numerous problems can occur.
Contact the Candidate Services Unit at (212) 306-7100 for more information.

Overview of C-SMART Submission Menu Screens

Draft Submission and Draft Amendment Screen

The Draft Submission and Draft Amendment screens allow you to review the results of a draft
submission or draft amendment before you run a final submission or amendment. The draft 
screen is accessed by going to the Submission menu, selecting Submission or Amendment, and
then selecting Draft. The following tasks are performed from within the Draft Submission or 
Draft Amendment screens.
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Generating a Draft Submission or Amendment

• Select the appropriate disclosure statement number within the Statement # drop 
down window.

• Select the All Schedules check box to view all applicable schedules, or select the
appropriate schedules you wish to view.

• Click the [proceed] button to run the draft.

For information on editing your unitemized and summary amounts, see page 109.

Viewing a Draft Submission or Amendment

• Examine a particular disclosure schedule by selecting it from the drop down list.

• View the selected disclosure schedule by going to the View menu and
selecting Print Preview or clicking the [Print Preview] button on the toolbar.

• Magnify part of the selected disclosure schedule by going to the View menu
and selecting Zoom or clicking the [Zoom] button on the toolbar.

• View the first page by going to the View menu and selecting First Page or
clicking the appropriate button on the toolbar.

• View the previous page by going to the View menu and selecting Prior Page
or clicking the appropriate button on the toolbar.

• View the next page by going to the View menu and selecting Next Page or
clicking the appropriate button on the toolbar.

• View the last page by going to the View menu and selecting Last Page or
clicking the appropriate button on the toolbar.

Printing a Draft Submission or Amendment

• Print the selected disclosure schedule by going to the File menu and selecting Print or
clicking the [Print] button on the toolbar. You can access the Printer Setup screen by
going to the File menu and selecting Printer Setup or clicking the [Printer Setup] button
on the toolbar. This will bring up the Print Options screen, which allows you to print the
entire schedule or designate a range of pages to be printed.
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• Print disclosure schedules by going to the File menu and selecting one of the four
printing options.

• Print — allows the printing of a range
of pages or the full document.

• Print All CFB — prints only the CFB
schedules.

• Print All BOE — prints only the BOE
schedules.

• Print All — prints the entire
submission.

Daily Pre-Election Disclosure

The Daily Pre-Election Disclosure statement must be filed by campaigns for the purpose of
reporting contributions and expenditures made during the 14 days preceding an election. You 
must report contributions or loans from a single source in excess of $1,000 and expenditures made
in excess of $20,000. This statement must be delivered by hand or faxed, if permission is requested
and granted, to the offices of the CFB within 24 hours after the listed contributions or loans are
accepted, or the listed expenditures are made. Candidates who are not in the primary election do
not have to file this report in the 14 days preceding the primary election. Candidates who are not 
in the general election do not have to file this report in the 14 days preceding the general election.

Pre-Election Disclosure Screen

This screen allows you to enter a date in the selection criteria and run a Daily Pre-Election
Disclosure report showing the contributions and loans of more than $1,000 and bills of
more than $20,000 you received on that particular day.
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You may perform the following functions from the Pre-Election Disclosure screen:

• Click the [Run] button to run the statement.

• Print the statement by going to the File menu and selecting
Print or clicking the [Print] button on the toolbar.

• Magnify part of the statement by going to the View menu and
selecting Zoom or clicking the [Zoom] button on the toolbar.

• View the first page by going to the View menu and selecting
First Page or clicking the appropriate button on the toolbar.

• View the previous page by going to the View menu and selecting
Prior Page or clicking the appropriate button on the toolbar.

• View the next page by going to the View menu and selecting
Next Page or clicking the appropriate button on the toolbar.

• View the last page by going to the View menu and selecting Last
Page or clicking the appropriate button on the toolbar.

Editing Unitemized and Initial Summary Amounts

Editing Initial Summary Amounts

When prompted during the submission
process, C-SMART will ask if you wish to
edit Unitemized and Initial Summary
Amounts. If you click [Yes], the Summary
Pages screen will become available to edit.
Should you not need to edit your Initial
Summary amounts, click [No] and 
C-SMART will continue with the
submission process.

The Summary Pages screen gives you the opportunity to set Initial Summary and Unitemized
amounts for a particular disclosure statement in C-SMART. These amounts are included in 
your submissions or amendments and are required by the CFB. C-SMART does not calculate
unitemized amounts for you.

If you have made any unitemized transactions during the disclosure statement period for which you
are running a submission or an amendment, you must enter the total unitemized amounts in the
unitemized fields.

The Recalculate Summary function in the Admin menu is used to recalculate summaries that are
kept in C-SMART. The Recalculate Summary function recalculates starting with the opening
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numbers in each committee’s first disclosure statement. Recalculate Summary should be used if any
of the summary numbers in any of the disclosure statements in C-SMART appear to be inaccurate,
possibly resulting from a computer crash while you were running C-SMART. For more information,
see the section on Recalculate Summary in the Admin menu subsection on page 69.

Editing Unitemized Amounts

Unitemized amounts represent the value of
small transactions that you have not entered
into C-SMART. These amounts can be
entered into C-SMART by clicking [Yes] when
C-SMART asks if you would like to edit
Unitemized or Summary Amounts during the
submission process. Clicking [Yes] will bring
you to the Summary Pages screen, where you
can edit your Unitemized amounts. Clicking
[No] will cause C-SMART to continue with
the submission process.

Unitemized Amounts for Schedules ABC and D

These include the value of small monetary and in-kind contributions that you have decided not 
to enter into C-SMART. These contributions will not be matchable. If you receive contributions 
of more than $100 from any contributor, you are required to itemize them. If you receive multiple
contributions from the same contributor that exceed $100 in total, you must itemize the contribution
that brings the total over $100 and all subsequent contributions from that contributor. Unitemized
contributions hamper the ability of C-SMART to facilitate your compliance, by bypassing the
tracking of contribution totals. You are still required to keep all records of unitemized contributions.

Unitemized Amounts for Schedule E

This includes the value of small receipts, other than contributions, that you have decided not to
enter into C-SMART. If you receive more than $100 from any single source, you are required to
itemize it. If you get multiple receipts from a single source that exceed $100 in total, you must
itemize the receipt that brings the total over $100 and all subsequent receipts from that source.
You are still required to keep all records of unitemized receipts.

Unitemized Amounts for Schedule F

This includes the value of small expenditure payments that you have decided not to enter into 
C-SMART. If you pay more than $50 to any vendor, you are required to itemize it. If you make
multiple payments to any vendor that exceed $50 in total, you must itemize the payment that 
brings the total over $50 and all subsequent payments to that vendor.

Termination Report

If a committee is terminating activities (by paying all liabilities and disbursing all funds in its
possession) before the last disclosure statement of an election is due, this should be indicated 
in the Termination Report section of the Submission Screen.
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Transactions Included in Disclosure Statements

When entering data into C-SMART, campaigns do not need to specify which disclosure statement 
a particular transaction will appear on. When C-SMART generates disclosure statements for a
particular period, the software determines what transactions should be included in that disclosure
statement based upon the transaction date, whether the transaction has already been submitted,
and what other submissions have been performed. Different transactions are included depending
upon the circumstances.

Submission

• Running a submission for the first time, for the most recent filing period: All
transactions that have not been previously reported and have a transaction date that
occurred during the selected statement period or any preceding statement period will 
be included in the current submission. For example, if Statement 2 is the most recent
statement, and submission for Statement 2 is being run, all unsubmitted transactions 
for Statement 1 (preceding statement) and 2 (selected statement) will be included.

• Rerunning a submission for the most recent filing period: All transactions which 
were previously submitted for the selected statement will be included. In addition, all
transactions that have not already been submitted and have a transaction date that will
place them in the selected statement period or any preceding statement period will be
included. For example, if Statement 2 is the most recent statement, and submission for
Statement 2 is being rerun, all transactions that were previously included in a Statement
2 submission will be included. All transactions that occurred during the Statement 1 and
Statement 2 disclosure statement periods but were not entered until after the Statement 2
submission was submitted will also be reflected in the current submission.

• Rerunning a submission for a prior disclosure statement: All transactions which were
previously submitted for the specific statement number that is now being resubmitted
will be included. No new transactions may be added. For example, if Statement 2 is the
most recently submitted statement, and Statement 1 submission is being run, C-SMART
will include only those transactions that were previously submitted for Statement 1.

Amendments

You may not amend a disclosure statement until you have already run final submission for that
statement and added, modified, or deleted transactions for that statement. In addition, each
amendment only includes changes made since the last time a final submission or final amendment
was made. If you generate a final amendment more than once, all final amendments must be
submitted in order. You may not file an amendment without prior approval from the Candidate
Services Unit.

• Amending the most recent disclosure statement: Any transaction that was disclosed in
the last submission or amendment and has been subsequently modified or deleted will
be included. In addition, all transactions that have not already been submitted and have
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a transaction date that would place them in the selected statement period, or any preceding
statement period, will be included. For example, if Statement 2 is the most recent
statement and Statement 2 is being amended, all transactions that were previously
included in a Statement 2 submission and have been modified or deleted will be
included. All transactions that occurred during the Statement 1 or Statement 2 period
but were not entered until after the Statement 2 submission was generated will also be
reflected in the current amendment.

• Amending a prior disclosure statement: Any transaction that was disclosed in the last
submission or amendment of that disclosure statement and has been subsequently
modified or deleted will be included. No new transactions may be added. For example, if
Statement 2 is the most recently submitted statement, and Statement 1 is being amended,
C-SMART will include only those transactions that were previously submitted for
Statement 1 and have been modified or deleted.

There is a gap of a few days between the end of a disclosure statement period and the due date 
of that disclosure statement to give you time to review and finalize your data. C-SMART will not
include transactions that fall between those days in that disclosure statement. They will be included
in the next disclosure statement. You may begin entering data for a subsequent disclosure statement
prior to submitting the prior disclosure statement without submitting those transactions too early.

Steps for Generating Disclosure Statements (Hard copy and Disk)

It is recommended that you follow the steps listed below when generating disclosure statements 
and amendments for the CFB and the BOE. Before doing so, please read the explanation of which
transactions will be included in a disclosure statement.

1. Review the Invalid Matching Claims report available under the Reports menu to identify
potential compliance problems with your data. You may also want to look at other reports
that may provide additional information about potential compliance problems. Modify
transactions as needed to resolve these issues. C-SMART does not perform numerous tests
that are relevant for determining whether transactions are in compliance with the Program.
It is your responsibility to comply with the rules and the Program. These reports are merely
tools to assist the campaign in their compliance with Program requirements.

2. Go to the Submission menu, select Submission or Amendment as appropriate, and
select Draft.

3. Use the appropriate list boxes to select the correct statement number and committee.

4. Click the [Proceed] button to begin the process. You will receive a prompt asking you
whether you would like to edit the Unitemized and Summary amounts. Click [Yes] if
you would like to edit those amounts.

generating disclosure statements9

chapter 9 | C-SMART v7.0 User Guide 112



5. Enter all Unitemized and Summary amounts. For more information on unitemized 
and summary amounts, see page 106. If the amounts are provided automatically by 
C-SMART, review them carefully to ensure their accuracy.

6. Go to the File menu and select Print All. This will generate a complete draft of your
disclosure statement.

7. Click the [Close] button to exit the screen.

8. Review the draft to ensure that it is complete, accurate, and in compliance with Program
requirements. Be sure to check your contributions to ensure that you have claimed
matching funds for those contributions which are eligible to be matched. Modify
transactions as needed to resolve any issues.

9. Backup your database on a blank, formatted disk. It is strongly recommended that you
keep this backup permanently. The submission and amendment processes make several
irreversible changes to your data. It may be necessary to restore data that you saved prior
to the formatting that occurred during submission. It is recommended that you note the
date on the backup disk label and indicate that the backup was made prior to
generating the disclosure statement. You are not to submit the backup disk to the
CFB unless requested to do so. It is the submission disk that you need to submit with
your disclosure statement or amendment.

10. Check your disk to make sure that the file information has gotten backed up to your
diskette. You can do this by selecting My Computer, then clicking 3 ½ floppy (a:). The
disk should contain a zip file named db2005.

You are now ready to produce a final submission or amendment. You have the choice of submitting
a hard copy to the Campaign Finance Board, which would need to be mailed or hand delivered, or
you can submit electronically via the Internet.

The following steps are for submitting a hard copy.

1. Insert a blank, formatted disk into your floppy disk drive. Because final submission
automatically prints your disclosure statements, make sure your printer is ready to print.

2. Go the Submission menu, select Submission
or Amendment as appropriate, and 
select Final.

3. Select the correct statement number,
committee, and floppy disk drive.

4. Click the [Proceed] button to begin the
process. You will receive a message
recommending that if you have not made 
a current backup of your data, to stop the submission process and create one now. If you
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have a current backup of your data, click the
[Yes] button to continue the submission
process.

5. You will receive a prompt asking if you
reviewed your statement to ensure that you
claimed matching funds. If you did not, click
the [No] button and review your draft
submission. If you did review the statement,
click the [Yes] button to proceed.

6. You will receive a prompt asking you whether
you would like to edit the Unitemized and Summary amounts. If you need to edit these
amounts, click the [Yes] button.

7. Correct any errors in the unitemized and summary amounts that you may have noticed
while reviewing the draft submission. For more information on this screen, see the
section “Editing Unitemized and Initial Summary Amounts” earlier in this chapter.

8. Click the [Proceed] button again to continue the process. You will receive a final prompt
informing you that the submission process will delete any information on your floppy
disk. After clicking [Yes] to continue the submission process, C-SMART will then
generate a printed copy of your disclosure statement on paper and an electronic copy of

your disclosure statement on your disk. During the process, C-SMART will execute the
WINZIP function, which will track the progress of the disclosure files being saved to
your disk.

9. After the WINZIP screen closes, C-SMART will perform some additional processing,
followed by a screen informing you that the process is completed. Clicking the [OK]
button will end the process.

10. At this time you will be given the opportunity to make additional copies by
selecting the File in the menu. If you do not need any additional copies or you
have finished printing your copies click the [Close] button to exit this screen.

Check your disk to make sure that the file information has been saved to your diskette. You can do
this by selecting My Computer, then clicking 3 ½ floppy (a:). The disk should contain a zip file
named csmart.
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• If you have a printed Schedule F, the C-SMART Zip file will contain CSMARTF.EXP.

• If you have a printed copy of Schedule ABC, D, or M, the C-SMART Zip file will contain
CSMARTM.EXP.

• If you have a printed copy of any unitemized amounts, the C-SMART Zip file will contain
CSMARTU.EXP. (Summary Page amounts are not included on the disk.)

• If you have a printed copy of any other disclosure schedules, the C-SMART Zip file will
contain CSMARTX.EXP.

If any of these files are missing, repeat steps 3–9. If these files are still missing, contact the
Candidate Services Unit.

To ready your disk for final submission and delivery to the CFB, follow the steps below.

1. Place a label on the disk including the election cycle, the date of the submission, your
CFB candidate ID, your CFB committee ID, the statement number, and a list of
schedules that are being submitted.

2. If this is the last disclosure statement you are filing for this committee, place an “X” in
the Termination report box and enter the date on which you paid your last liability.

3. C-SMART creates two separate and complete disclosure statements. One for the CFB and
one for the BOE. Print an additional copy for your own records.

4. The candidate or treasurer must sign and date both the CFB Cover Sheet and the BOE
Cover Sheet. You must submit documents with an original signature. Disclosure
statements that include only photocopies of the signature will not be considered valid.
Please keep in mind that C-SMART does not complete all the information on the BOE
Cover Page. For instructions on how to complete the BOE Cover Page, call the BOE at
(212) 487-5300.

5. If you indicated that you were going to fill out the Summary Pages manually, do so.

6. If you are running a submission, and you have previously run final submission for that
disclosure statement, C-SMART will generate a Cross-Reference report that itemizes all
changes made since the last submission of, or amendment to, that disclosure statement.

7. Place the Cross-Reference report with the disclosure statement for the CFB. If you 
run a resubmission without changing any information for that disclosure statement, a
Cross-Reference report will not be generated.

8. Place the labeled submission disk with the disclosure statement for the CFB.

9. Check both piles against the Submission Checklist generated in the submission process.
Disclosure schedules are produced by C-SMART based on financial activity prior to the
end of the disclosure statement period. Not all schedules will be produced for each
disclosure statement period. For information about what information C-SMART includes
in a disclosure statement, see Including Transactions in Disclosure Statements, below.
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Generating Internet Disclosure Statements and Amendments

If your campaign has an active internet connection you may submit your disclosure statements 
over the internet. Your campaign must first obtain a temporary Internet Delivery Password from
the Candidate Services Unit. Once you have this password, only the Candidate or the Treasurer 
will be allowed to file disclosure statements over the internet.

1. Go to the Submission menu, select Submission or Amendment, as is appropriate. Select
Final, and Internet.

2. The first time you attempt to file an Internet Disclosure Statement you will be prompted
to enter your CFB designated password, and then click the [ Proceed ] button.

3. You will be prompted to enter a new password of your choice to ensure the system's
security.

• Please note, if at any time you enter your password for internet submission incorrectly six
times in a row, your account will be automatically suspended. You must contact the
Candidate Services Unit to have your account reactivated.

4. Upon entering a correct password you will be logged on to the CFB's server. You will
then proceed to file a statement in the same manner as you would with the disk filing.

5. Select the correct Statement number.

6. Click the [Proceed] button to begin the process. You will receive a message recommending
that if you have not made a current backup of your data, to stop the submission process
and create one now. If you have a current backup of your data, click the [Yes] button to
continue the submission process.
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7. You will receive a prompt asking if you reviewed your statement to ensure that you
claimed matching funds. If you did not, click the [No] button and review your draft
submission. If you did review the statement, click the [Yes] button to proceed.

8. You will receive a prompt asking you whether you would like to edit the Unitemized 
and Summary amounts. If you need to edit these amounts, click the [Yes] button.

9. Correct any errors in the unitemized and summary amounts that you may have noticed
while reviewing the draft submission. For more information on this screen, see the
section “Editing Unitemized and Initial Summary Amounts” earlier in this chapter.
Click [ Proceed ] to continue.

10. Once you are in the Candidate/Treasurer Verification screen, you must verify that the
candidate or the treasurer is filing the Statement or Amendment. Check off the final
confirmation, and click [ Proceed ].

11. Your Statement or Amendment will then process, a copy will be sent to your printer and
a confirmation receipt will be emailed to you.

12. At this time you will be given the opportunity to make additional copies by selecting the
File in the menu. If you do not need any additional copies, or if you have finished
printing your copies, click the [Close] button to exit this screen.

13. Submit the CFB statement to the CFB, and submit the BOE statement to the BOE. Every
disclosure statement must be filed by the disclosure statement due date. It may either be
delivered to each agency by 5:00 p.m. or postmarked by 11:59 p.m. on the disclosure
statement due date. If you mail the disclosure statement, it is your burden to prove that
you mailed it on time. It is therefore recommended that you mail your statement via
certified mail or through a company with document tracking, like Fed-Ex. Be advised
that statements mailed to the CFB may not be received in time for a payment review to
be completed. To ensure that your statement will be eligible for the next public funds
payment, the CFB recommends that you hand deliver your statements to the CFB.
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14. Backup your database after the submission process is completed. It is strongly
recommended that you keep this backup permanently. If anything goes wrong with
subsequent data entry it may be helpful to be able to restore the data to its state
immediately after the last time you generated disclosure statements. It is recommended
that you note the date on the disk label and indicate that the backup was made after
generating the disclosure statement.

Steps for Generating Daily Pre-Election Disclosure Statements

Although this process produces a filing for public disclosure, C-SMART generates these statements
in a way similar to the production of the various reports offered by C-SMART. Please see Chapter 8
for more information on reports.

1. Go to the Submission menu and select Pre-Election Disclosure.

2. In the Selection Criteria box, enter the appropriate date for the contributions, loans, or
expenditures you would like included in the statement.

3. Run the statement by clicking on the [run] button.

4. Review the statement to ensure that it is complete, accurate, and in compliance with
Program requirements. Modify transactions as needed to resolve any issues.

5. Go to the File menu and select Print. This will generate the Daily Pre-Election
Disclosure statement.

6. Make a copy of the statement for your records.

Please fax or hand deliver your Daily Pre-Election Disclosure statement to the CFB within 24 hours
of printing.
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Submission Checklist (except for Internet submissions)

For the New York City Campaign Finance Board Only
(Not for the Board of Elections)

Disclosure schedules are produced by C-SMART based on financial activity prior to the end of the disclosure statement period.
Not all schedules will be produced for all disclosure statement periods.

• Submission Diskette(s)
Diskette requires a label with the Election Cycles, CFB Candidate ID, CFB Committee ID, Statement Number, and List of Submitted 
Disclosure Schedules.

• CFB Cover Page
Requires original signature.

• Schedule ABC: Monetary Contributions

• Schedule D: In-kind Contributions

• Schedule E: Other Receipts

• Schedule F: Expenditure Payments

• Schedule G: Transfers In

• Schedule H: Transfers Out

• Schedule I: Loans Received

• Schedule J: Loans Repaid

• Schedule K: Liabilities / Loans Forgiven

• Schedule L: Expenditure Refunds

• Schedule M: Contributions Refunded and Other Receipts Adjustments

• Schedule N: Outstanding Liabilities

• Schedule O: Partners/LLC Members

• Schedule O-1: Subcontracts

• Schedule P: Advance Purchases

• Schedule V: Intermediary Information

• Schedule W: Affiliated Contributions

• Summary Pages:
Complete all missing items in the Summary Pages.

• Cross Reference Report
Submit this document if it is generated.

• Backup Documentation
Backup Documentation must be submitted with each disclosure statement. Please see Candidate Handbook for required backup documentation.

• List of Fundraising Agents
Fundraising agents include full-time campaign workers and commercial fundraising consultants.
Please see the Candidate Handbook for more information on fundraising agents.

• Loan Documentation
Copy of evidence of indebtedness (e.g., loan agreement, promissory note etc.)
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Submission Checklist

For the New York City Board of Elections Only
(Not for the Campaign Finance Board)

Disclosure schedules are produced by C-SMART based on financial activity prior to the end of the disclosure statement period.
Not all schedules will be produced for all disclosure statement periods.

• Schedule A: Monetary Contributions: Individuals and Partnerships

• Schedule B: Monetary Contributions: Corporate Contributions

• Schedule C: Monetary Contributions: All Others

• Schedule D: In-kind Contributions

• Schedule E: Other Receipts

• Schedule F: Expenditure Payments

• Schedule G: Transfers In

• Schedule H: Transfers Out

• Schedule I: Loans Received

• Schedule J: Loans Repaid

• Schedule K: Liabilities / Loans Forgiven

• Schedule L: Expenditure Refunds

• Schedule M: Contributions Refunded and Other Receipts Adjustments

• Schedule N: Outstanding Liabilities

• Schedule O: Partners/LLC Members

• Schedule O-1: Subcontracts

• Summary Pages:
Complete all missing items in the Summary Pages.

• BOE Cover Page
Requires original signature.

• Loan Documentation
Copy of evidence of indebtedness (e.g., loan agreement, promissory note etc.)
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Q1: I can’t enter a matchable amount for a contribution!

A1: • Make sure it is a monetary contribution.

• Make sure the contributor’s Name Code (N Code) is CAN, FAM, IND, or SPO.
Contributions made by Corporations (CORP), Political Committees (PCOMC,
PCOMP, or PCOMZ), Partnerships (PART), or Employee Organizations (EMPO)
cannot be matched.

• Make sure that the borough code is not Z. Out-of-city contributions cannot be
matched.

Q2: Delete doesn’t work!

A2: • Transactions: You must delete any associated transactions before you may delete a
transaction.

• Names: You must delete any transactions in which a name is used before you may
delete a name. In addition, the name cannot serve as an intermediary for any
transactions if it is to be deleted.

• Bank Accounts: You must delete any transactions in which a bank account is used
before you may delete a bank account.

• Committees: You must delete any bank accounts and transactions in which a
committee is used before you may delete a committee.

Q3: Transactions are missing from my submission!

A3: • Make sure the transactions were entered into C-SMART. If not, they need to be
entered.

• Make sure the date of the transaction comes before the final date of the disclosure
period for that statement. Each disclosure period ends four days before the disclosure
statement due date.
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Q4: My submission includes transactions that belong in a previous statement!

A4: C-SMART includes all transactions with dates that come before the final date of the
disclosure period for which the submission is being run. As a result, any transactions
from previous disclosure periods that were not submitted to the CFB will be included
when a subsequent statement is run.

Q5: My amendment does not include new transactions that belong in that disclosure
statement!

A5: You may not add new transactions to a disclosure statement once you have filed a
subsequent disclosure statement, therefore your amendments will only produce
modifications made to that disclosure statement. Please remember that you may not
submit amendments to the CFB without the approval of the Candidate Services Unit.

Q6: C-SMART is unfairly invalidating contributions because of missing employment
information!

A6: C-SMART will warn you if any employment information is missing if the contributor
gives more than $99 unless the occupation is “Unemployed”, “Homemaker”, “Retired”, or
“Student”. C-SMART will not recognize any variation of those occupation titles, and it
will not recognize these values if they are typed into any other field. Contributions from
those giving over $100 may still be valid even without full employment information if
the campaign has documented its best efforts to obtain the missing employment
information. Although C-SMART will not count contributions received from such
contributors as valid in the threshold estimate, the Campaign Finance Board will not
automatically invalidate such contributions.

Q7: What’s my USER ID and password?

A7: If you have not changed you security settings, your USER ID and Password are both 
the word “ADMIN”. If you have changed your USER ID and Password settings, please
contact the Candidate Services Unit at 212-306-7100.
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